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Manual Overview

Warnings, Cautions, and Notes

Warnings

Warnings are extremely important recommendations, violating which may result in either 
injury to yourself or others, or damage to your analyzer and/or data. Warnings will always be 
identified as Warnings in the text, and will always be visually presented as follows:
WARNING  This is a Warning.

Example Warning:
WARNING  Tampering with the 5,500 ppm (Lead high) lead-in-soil standard may cause 
exposure to lead dust. Keep all standards out of reach of children.

Cautions

Cautions are important recommendations. Cautions will always be identified as Cautions in 
the text, and will always be visually presented as follows:
CAUTION  This is a Caution.

Example Caution:
CAUTION  Never tamper with Test Standards. They should not be used unless they are 
completely intact

Contents

• “Warnings, Cautions, and Notes” on page 1

• “Figures” on page 2

• “Physical Buttons” on page 2

• “Other Hardware” on page 3
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2 Manual Overview
Figures
Notes

Notes are informational asides which may help you with your analyses. Notes will always be 
identified as Notes in the text, and will always be visually presented as follows:
Note  This is a Note.

Example Note:
Note  For defensible Quality Control, keep a record of the time and precision of every 
calibration

Figures
Figures are illustrations used to show what something looks like. Figures will always be labeled 
and identified as Figures directly below the Figure itself, and will always be visually presented 
as follows:

Figure 1. This is a Figure

Physical Buttons
Physical Buttons are actual buttons on the analyzer which must be pushed to activate their 
function. Physical Buttons will always be identified as Buttons in the text, and will always be 
visually presented as follows:

Example Physical Buttons:

On/Off/Escape Button, Clear/Enter Button, Interlock Button, and Trigger Button.
2 Niton XL2 Plus User’s Guide Thermo Scientific



 2 Manual Overview
Other Hardware
Other Hardware
Other Hardware refers to any physical part of the analyzer which performs a necessary 
function. Other Hardware will always be visually presented as follows:

This is an example of Other Hardware.

Example Other Hardware:

Battery, Touch Screen Display, Measurement Window, and USB Cable
Thermo Scientific Niton XL2 Plus User’s Guide 3
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3

Using Your Analyzer

This section discusses the basics of using your analyzer. Radiation safety is covered first, 
because using an X-ray based analyzer safely is very important. Secondly, we outline the daily 
startup procedure to ensure that your analyzer is performing properly and at its most efficient 
level.   

Intended Use
Get fast, accurate metal alloy verification for manufacturing quality assurance with the 
Thermo Scientific™ Niton™ XL2 Plus Analyzer. The XL2 Plus Analyzer provides immediate, 
nondestructive elemental analysis of alloy materials from titanium to nickel as well as tramp 
and trace element analysis. Lightweight, rugged handheld Niton XL2 Plus Analyzers are well 
suited for a growing list of applications including scrap metal identification, mining and 
exploration, and lead screening for consumer and electronic goods.

Contents

• “Intended Use” on page 5

• “Safely and Effectively Using Your Analyzer” on page 6

• “Operational Specifications for Niton XL2 Plus Analyzer” on page 20

• “Radiation and Compliance Labels” on page 21

• “Battery Installation and Charging” on page 23

• “Hot Swap Feature” on page 26

• “Emergency Response Information” on page 26
Thermo Scientific Niton XL2 Plus User’s Guide 5



3 Using Your Analyzer
Safely and Effectively Using Your Analyzer
Navigation

Use the touch screen or keypad to access XL2 Plus features. 

Safely and Effectively Using Your Analyzer

CAUTION  Niton analyzers are not intrinsically safe analyzers. All pertinent Hot Work 
procedures should be followed in areas of concern.

CAUTION  If the equipment is used in a manner not specified by Thermo, the protection 
provided by the equipment may be impaired. 

WARNING  Always treat radiation with respect. Do not hold your analyzer near the 
measurement window during testing. Never point your analyzer at yourself or anyone else 
when the shutter is open. 

Serviceable Parts

There are no user serviceable parts. All repairs must be performed by factory trained 
technicians.

USB, Remote Trigger, Serial, and Power Ports

Wrist Strap Anchor Stylus Holder

Clear/Enter ButtonOn/Off/Escape Button

Interlock 4-Way Touch Pad

Bluetooth Indicator

Safety LED IndicatorSafety LED Indicator

 Pass/Fail Indicator

Touch Screen
6 Niton XL2 Plus User’s Guide Thermo Scientific
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 3 Using Your Analyzer
Safely and Effectively Using Your Analyzer
Ergonomics

The Niton XL2 Plus analyzer is ergonomically designed. This lightweight, compact, and 
balanced instrument minimizes strain on the user, especially on extended jobs. Three separate 
test stands provide added ergonomic support for development, calibration or anytime you 
need to test samples repeatedly and for long periods of time. For more information see “Test 
Stands” on page 165.

Unintentional Misuse

Take caution to avoid unintentional misuse, which is not covered on the service warranty. 
Examples of unintentional misuse include: 

• letting the analyzer slip out of your hand in a damp environment

• standing the analyzer upright on the battery, putting it at high risk of falling off a counter 
or desktop

Radiation and General Safety

This section covers topics related to radiation safety and general safety when using a Thermo 
Scientific Niton XL2 Plus analyzer. At a minimum all operators of the analyzer should be 
familiar with the instructions provided in this chapter in order to handle the analyzer in a safe 
manner. In addition to reading the information presented on the following pages, Thermo 
Fisher Scientific recommends that anyone operating the XL2 Plus analyzer participate in a 
radiation safety and operational training class. You can find courses online at 
https://portables.thermoscientific.com/. Login and search for “radiation safety training”.

Radiation Protection Basics

The Niton Model XL2 Plus analyzer contains an x-ray tube which emits radiation only when 
the user turns the x-ray tube on. When the x-ray tube is on and the shutter is open, as during 
a measurement, the analyzer emits a directed radiation beam - see Figures 1-1 and 1-2. 
Reasonable effort should be made to maintain exposures to radiation as far below dose limits 
as is practical. This is known as the ALARA (As Low as Reasonably Achievable) principle. For 
any given source of radiation, three factors will help minimize your radiation exposure: Time, 
Distance, and Shielding.

Time

The longer you are exposed to a source of radiation the longer the radiation is able to interact 
in your body and the greater the dose you receive. Dose increases in direct proportion to 
length of exposure.
Thermo Scientific Niton XL2 Plus User’s Guide 7
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3 Using Your Analyzer
Safely and Effectively Using Your Analyzer
Distance

The closer you are to a source of radiation, the more radiation strikes you. Based on geometry 
alone, dose increases and decreases with an inverse-squared relation to your distance from the 
source of radiation (additional dose rate reduction comes from air attenuation). For example, 
the radiation dose one foot from a source is nine times greater than the dose three feet from 
the source. Remember to keep your hands and all body parts away from the front end of the 
analyzer when the shutter is open to minimize your exposure.

Shielding

Shielding is any material that is placed between you and the radiation source. The more 
material between you and the source, or the denser the material, the less you will be exposed 
to that radiation. Supplied or optional test stands are an additional source of shielding for 
analysis. A backscatter shield accessory is also available and may be appropriate in some 
applications.

Exposure to Radiation

Human dose to radiation is typically measured in rem, or in one-thousandths of a rem, called 
millirem (mrem), 1 rem = 1000 mrem. Another unit of dose is the Sievert (Sv), 1 Sv = 100 
rem. The allowable limit for occupational exposure in the U.S (and many other countries) is 
5,000 mrem/year (50 mSv/year) for deep (penetrating) dose and 50,000 mrem/year (500 
mSv/year) for shallow (i.e., skin) dose or dose to extremities. Deep, shallow, and extremity 
exposure from a properly used Niton XL2 Plus analyzer should be less than 200 mrem per 
year, (2.0 mSv per year) even if the analyzer is used as much as 2,000 hours per year, with the 
shutter open continuously. The only anticipated exceptions to the 200 mrem maximum 
annual dose are: 1) routine and frequent analysis of plastic samples without use of a test stand, 
backscatter shield, or similar additional protective measures, or 2) improper use where a part 
of the body is in the primary beam path.

Note  NEVER OPERATE THE DEVICE WITH A PART OF YOUR BODY IN THE 
PRIMARY BEAM PATH OR WITH THE PRIMARY BEAM PATH DIRECTED AT 
ANYONE ELSE.

Also, consider the use of protective accessories such as a shielded test stand or backscatter 
shield (or equivalent) when performing routine and/or frequent analysis of any of the 
following:

• light materials (such as plastic, wood, or similarly low density/low atomic mass 
samples)

•  thin samples (such as foils, circuit boards, and wires)

•  samples that are smaller than the analysis window.
8 Niton XL2 Plus User’s Guide Thermo Scientific
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 3 Using Your Analyzer
Safely and Effectively Using Your Analyzer
Shown in Table 1 are the typical background radiation doses received by the average member 
of the public. The radiation dose limits for radiation workers in the US are also shown in 
Table 2.

Table 1. Typical Radiation Doses Received (Source: NCRP 1987)
Category Dose in mrem Dose in mSv

Average total dose in US (annual) 360 3.6

Average worker exposure (annual) 210 2.1

Average exposure for an underground 
miner

400 4.0

Exposure for airline crew (1,000 hours at 
35,000 ft)

500 5.0

Additional from living in Denver at 5300’ 
(annual)

25 .25

Additional from 4 pCi/l radon in home 1,000 10.0

Typical Chest X-Ray 6 0.06

Typical Head or Neck X-Ray 20 0.2

Typical pelvis/hip x-ray 65 0.65

Typical lumbar spine x-ray 30 0.3

Typical Upper G.I. x-ray 245 2.45

Typical Barium enema x-ray 405 4.05

Typical CAT scan 110 1.10

Table 2.  Annual Occupational Dose Limits for Radiation Workers (Source: 
Code of Federal Regulations Title 10, Part 20)

Category Dose in mrem Dose in mSv

Whole Body 5000 50

Pregnant Worker (during gestation 
period)

500 5

Eye Dose Equivalent 15,000 150

Shallow dose equivalent to the skin or 
any extremity or organ

50,000 500

Maximum allowable dose for the general 
public (annual)

100 1.0

For a Minor 500 5.0
Thermo Scientific Niton XL2 Plus User’s Guide 9



3 Using Your Analyzer
Safely and Effectively Using Your Analyzer
Monitoring your radiation exposure

Individuals can be monitored for the radiation dose they receive by use of radiation dosimetry 
devices (dosimeters). Monitoring dose using a dosimeter can be a way of identifying improper 
use and at the same time demonstrating proper use. In some locations, dosimetry is required 
by regulations and in others it is optional. It is normally required when the user could 
reasonably be expected to receive in excess of 10% of the annual dose limit. Thermo Fisher 
Scientific recommends that you determine and obey the local regulatory requirements 
concerning radiation monitoring of occupational workers.

Two common types of dosimeters are whole-body badges and ring badges. Whole body 
badges are often attached to the user’s torso (e.g., clipped to the collar, shirt pocket, or waist as 
appropriate). A ring badge is worn on the finger as a measure of maximum extremity dose. 
When worn, the specific location of the dosimeter should be that part of the body that is 
expected to receive the highest dose. This location will depend on how the analyzer is used 
and so it may not be the same for all users. Dosimetry services are offered by many companies. 
Two companies offering dosimetry services in the USA and much of the world are:

Note  Wearing a dosimeter badge does not protect you against radiation exposure. A 
dosimeter badge only measures your exposure (at the dosimeter location).

Pregnancy and Radiation Exposure

International guidance documents (e.g., ICRP Publication 60 and NCRP Publication 116*) 
recommend that the radiation dose to the embryo/fetus of a pregnant woman should not 
exceed a total of 500 mrem (10% of normal radiation worker limit) during the gestation 
period. While this dose limit exceeds the dose limit to a trained operator, pregnant workers 
may want to take special precautions to reduce their exposure to radiation. For more 
information see the U.S. NRC Regulatory Guide 8.13 “Instruction Concerning Prenatal 
Radiation Exposure” which can be found on the resource CD.

* The International Commission on Radiological Protection, ICRP, is an independent 
Registered Charity, established to advance for the public benefit the science of radiological 
protection, in particular by providing recommendations and guidance on all aspects of 
protection against ionizing radiation.

Company Global Dosimetry Solutions Landauer, Inc.

Address 2652 McGaw Avenue 2 Science Road

City and State Irvine, CA 92614 Glenwood, IL 60425-9979

Website www.dosimetry.com www.landauerinc.com

Phone Number (800) 251-3331 (800) 323-8830
10 Niton XL2 Plus User’s Guide Thermo Scientific



 3 Using Your Analyzer
Safely and Effectively Using Your Analyzer
* The National Council on Radiation Protection and Measurements (NCRP) was chartered 
by the U.S. Congress in 1964 as the National Council on Radiation Protection and 
Measurements.

How to Use the Niton XL2 Plus Analyzer Safely

The Niton XL2 Plus analyzer is designed to be safe to operate provided that it is used in 
accordance with manufacturer's instructions. Under conditions of normal use, monitored 
operators seldom receive a measurable dose and have not been known to receive in excess of 
10% of the annual occupational dose limits (a criteria that would require monitoring under 
regulation in the U.S.). In addition to proper use of the analyzer, it is recommended that you 
follow these precautions to ensure your safety and the safety of those around you.

Know where the beam is

The primary beam is a directed beam out of the front of the analyzer that can have high dose 
rates. The secondary beam, or scattered beam, has much lower dose rates.

Figure 2. Primary Beam
Thermo Scientific Niton XL2 Plus User’s Guide 11



3 Using Your Analyzer
Safely and Effectively Using Your Analyzer
Figure 3.     Secondary (Scattered) Beam

The Shutter-Open Indicator Lights

When the lights are flashing, the primary beam is on, and radiation is being emitted from the 
front of the analyzer.

 

Figure 4.     The X-ray Beam Indicator Lights
12 Niton XL2 Plus User’s Guide Thermo Scientific



 3 Using Your Analyzer
Safely and Effectively Using Your Analyzer
Handle and Use with Respect

Avoid holding the front of the analyzer when the x-ray tube is energized and the shutter is 
open. Never point the instrument at yourself or anyone else when the shutter is open and the 
x-ray tube is energized. Never look into the path of the primary beam.

Follow a Radiation Protection Program

Your organization should establish, document, and follow a Radiation Protection Program. 

Take Proper Care of your Niton XL2 Plus

Keeping your analyzer maintained in good condition will help minimize the risk of accidental 
exposure. Mechanical malfunction of the shutter can be avoided by maintaining the 
measurement window, as described in the User Guide. This prevents foreign objects from 
entering your analyzer.

The XL2 Plus Analyzer is equipped with Detector ProGuard, a detector protection grid. 
While the Detector ProGuard helps to minimize accidental detector punctures, care must be 
taken to avoid introducing sharp objects to the analyzer measurement window area. Under 
Manufacturer standard terms and conditions, detector punctures will not be covered under 
warranty.

Avoid Over-Exposures

Direct contact with the window could result in overexposures in the times indicated inTable 3 
below.

Extremity is defined by the NRC as the hand, elbow, arm below the elbow, foot, knee, or leg 
below the knee. Whole Body is defined by the NRC as the head, trunk (including male 
gonads), arms above the elbow, or legs above the knee.

Table 3. Potential Exposure Limit Times
Location of Dose Limit Time to Reach Limit

Deep Dose / 
Whole Body

5 rem (50 mSv) 2.1 minutes

Shallow Dose / 
Extremities

50 rem (500 mSv) 0.95 minutes

Member of Public 
(i.e. untrained 
operator)

0.1 to 5 rem (1 to 50 mSv) 2.5 to 9.5 seconds
Thermo Scientific Niton XL2 Plus User’s Guide 13



3 Using Your Analyzer
Safely and Effectively Using Your Analyzer
Safe Handling of Samples

As mentioned many times in this chapter, never place any part of your body in the path of the 
x-ray beam. There is always a safe way to handle samples whether they are small, irregularly 
shaped, or of low density. Never look into the path of the primary beam.

Small Samples

A small sample would be any sample that is smaller than the measurement window. Small 
samples present a unique risk because they don’t block the entire beam path. The difficulty 
with placing small samples down on a work surface to analyze them is that you may get 
readings from the work surface that interfere with analytical results. A test stand is an effective 
way of analyzing small samples accurately and safely. Never hold samples during analysis or 
look into the path of the primary beam.

Irregularly Shaped Samples

Irregularly shaped samples may not allow the proximity button to be depressed, or they may 
not entirely cover the primary beam and cause additional scattering. A back scatter shield is a 
safe way of reducing your radiation exposure while effectively analyzing an irregularly shaped 
sample.

Light Materials (such as plastics).

X-rays are attenuated more by denser and higher atomic mass materials, and less through 
lighter materials such as plastic. This causes higher dose rates in the scattered radiation. If you 
are frequently handling low density samples, you should consider the use of test stands, 
backscatter shields, or the equivalent. For more information see “Test Stands” on page 165.
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Niton XL2 Plus Radiation Profile

Radiation Meter Information

Model: Rad-Eye B20 

SN: 30776

Cal Due: 08/04/2018

Background Radiation Level

<0.01 mR/hr

Table 4 - Scatter Measurements off various substrates - Dose Rates in mRem/hr

Table 4. Niton XL2 Plus Radiation Profile - Scatter Measurements - mRem/hr

kV uA Range Substrate Max @ 5cm Max @ 30 cm Max @ Trigger

6.2 200 Low Aluminum <0.02 <0.02 <0.02

6.2 200 Low Stainless <0.02 <0.02 <0.02

6.2 200 Low Plastic <0.02 <0.02 <0.02

6.2 200 Low Soil <0.02 <0.02 <0.02

8 200 Low Aluminum <0.02 <0.02 <0.02

8 200 Low Stainless <0.02 <0.02 <0.02

8 200 Low Plastic <0.02 <0.02 <0.02

8 200 Low Soil <0.02 <0.02 <0.02

45 44 Main Aluminum 0.82 0.075 0.028

45 44 Main Stainless 0.04 <0.02 <0.02

45 44 Main Plastic 3.5 0.25 0.36

45 44 Main Soil 1.2 0.10 0.10
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Table 5 - Scatter Measurements off various substrates - Dose Rates in μSv/hr

Notes:

Scatter measurements were taken at a radius of 5 or 30 cm around the nose of the analyzer 
with the highest scatter dose rate being recorded.

Table 5. Niton XL2 Plus Radiation Profile - Scatter Measurements - μSv/hr

kV uA Range Substrate Max @ 5cm Max @ 30 cm Max @ Trigger

6.2 200 Low Aluminum <0.2 <0.2 <0.2

6.2 200 Low Stainless <0.2 <0.2 <0.2

6.2 200 Low Plastic <0.2 <0.2 <0.2

6.2 200 Low Soil <0.2 <0.2 <0.2

8 200 Low Aluminum <0.2 <0.2 <0.2

8 200 Low Stainless <0.2 <0.2 <0.2

8 200 Low Plastic <0.2 <0.2 <0.2

8 200 Low Soil  <0.2  <0.2  <0.2

45 44 Main Aluminum 8.2 0.75 0.28

45 44 Main Stainless 0.4 <0.2 <0.2

45 44 Main Plastic 35 2.5 3.6

45 44 Main Soil 12 1.0 1.0
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Table 6 - In Beam Measurements - Dose Rates in Rem/hr

Table 7 - In Beam Measurements - Dose Rates in mSv/hr

Notes:

In beam dose rates were measured using optically stimulated luminescent (OSL) dosimeters.

Reported results are based on measurement results that have been reduced to 2 significant 
digits by rounding up. For example, a measurement result of 1441 would be reported as 1500.

Table 6. Niton XL2 Plus Radiation Profile - In Beam Measurements - Rem/hr

kV uA Range Contact Deep Contact Shallow 5cm Deep 30cm Deep

6.2 200 Low <1.0 510,000 <1.0 <1.0

8 200 Low 24 2,000,000 4.0 <1.0

45 44 Main 58,000 200,000 9,400 860

Table 7. Niton XL2 Plus Radiation Profile - In Beam Measurements - mSv/hr

kV uA Range Contact Deep Contact Shallow 5cm Deep 30cm Deep

6.2 200 Low <0.010 5,100 <0.010 <0.010

8 200 Low 0.24 20,000 0.040 <0.010

45 44 Main 580 2,000 94 8.6
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Figure 5.     Primary and Secondary Dose Locations (Not to Scale)
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 3 Using Your Analyzer
Safely and Effectively Using Your Analyzer
Primary Radiation

Primary radiation is radiation that is produced by the analyzer and emitted out through the 
measurement window. Individuals should never place any part of their body in the primary 
beam path when the x-ray tube is on. There should always be a sample in contact with the 
measurement window when the x-ray tube is on. The sample will absorb most of the 
primary-beam radiation unless it is smaller than the instrument's measurement window or of 
low atomic mass, low density, and/or very thin. Caution should be taken when analyzing 
samples that are small, thin, and/or low in atomic mass or density as they may allow much 
more of the primary beam to escape. 

Secondary Radiation

Under conditions of normal and proper use, individuals can be exposed to secondary (or 
“scattered”) radiation. Secondary radiation is low-level radiation that emanates from the 
sample being analyzed as a result of primary beam radiation scattering in the sample or 
primary beam radiation inducing fluorescent x-rays in the sample. Dose points A, A’ and B in 
Figure 5 are examples of where you can encounter secondary radiation. The magnitude of this 
secondary radiation is sample dependent. Higher atomic mass and density samples such as 
steel will emit the lowest levels as they absorb most primary and secondary radiations. Lower 
atomic mass and density samples such as aluminum, wood, and especially plastic, will produce 
higher levels of secondary radiation. 

The operator is reminded that one should never hold samples during analysis, doing so will 
result in higher than necessary exposure to secondary radiation and could expose the operator 
directly to the much higher primary-beam dose rates.

Deep and Shallow Dose

You will find in Table 6 and Table 7 that shallow dose rates are listed for some dose points. All 
dose rates listed in these four Tables are deep dose unless they are specifically identified as 
shallow dose. Deep dose is dose from penetrating radiation that is delivered to both skin and 
underlying tissues and organs and is the type most commonly referred to when describing 
external radiation hazards. Occupational deep dose is limited to a maximum of 5 rem (50 
mSv) per year in the United States and most countries internationally. Deep dose is measured 
at 1.0 cm below the skin surface.

Shallow dose is often referred to as “skin dose” because it is a result of low penetrating 
radiation that only interacts with the skin. Shallow dose is limited to a maximum of 50 rem 
(500 mSv) per year in the United States and most countries internationally. Shallow dose is 
listed for primary in-beam dose points only because the low penetrating radiation that causes 
shallow dose is nearly all absorbed by a sample and does not produce any significant secondary 
radiation. Shallow dose is measured at a point 0.007 cm below the surface.
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Operational Specifications for Niton XL2 Plus Analyzer

Specification Value

Weight With battery: 3.4 lbs (1.53 kg)

Size • Length: 10.2 inches (25.87 cm)

• Width: 3.1 inches (7.7 cm)

• Height: 10.4 inches (26.29 cm)

Electrical rating 12 V DC, regulated

Power rating 12v 3A 36W

Ingress Protection (IP) rating Tested against IEC 60529 Degrees of Protection, IP-54

X-ray Tube Max 2W, 45kV, 200uA

Library For General Metals Mode: Niton Alloy Library 
v8.4C_800 and v8.4C_900 

Calibration Modes General Metals, Precious Metals, Soils, Mining, Plastics, 
Lead-in-Paint Industrial Analysis, Lead-in-Painted 
Product Analysis, Coatings, and Electronic Alloys.

Data export formats .csv, .xls, .txt

Battery LI-ION, 7.4V, 7.8AH

Ambient operating temperature 0-50 C

Humidity 0-80% Relative Humidity, Non-condensing

Cold Storage -20 C

Hot Storage 70 C

Elevation Sea level to 2600 meters (8530 ft.)

Language configuration English, French, Spanish, Portuguese, German, Chinese, 
Russian, Korean, Italian, Japanese, and Czech.

Computer administration The analyzer uses the Niton Data Transfer (NDT) suite 
of applications. Includes: Niton Data Transfer (NDT) 
and Niton Data Transfer Remote (NDTr). These 
applications run on a PC via a USB connection.

<1 mSv/hr @ 1 meter

Compliance CE, RoHS, FCC, Industry Canada, Safety to IEC 
61010-1; UL61010-1, IP54
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Radiation and Compliance Labels
Labels Description

This is the radiation caution label. It notifies you that energy 
from the laser exits the laser aperture. Because this radiation 
can harm the eyes, take care to protect your eyes suitably. The 
label is located on the bottom of the analyzer nose.

This is the x-ray caution label. It provides a warning that the 
analyzer emits a high intensity x-ray beam. The label is 
located near the analyzer nose. 

This CE label certifies compliance with part 15 of the FCC 
Rules. Operation is subject to the following two conditions: 
(1) this device may not cause harmful interference, and (2) 
this device must accept any interference received, including 
interference that may cause undesired operation.

The label is located near the handle. 

This caution label warns that the instrument produces x-rays 
and should only be operated by authorized personnel.

The label is located under the analyzer nose. 
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User Accessible Connectors on Niton XL2 Plus Analyzer

Storage and Transportation

Storage

Regulations in nearly all locations will require that you store your analyzer locked in a secured 
area to prevent access, use, and/or removal by unauthorized individuals. Storage requirements 
will vary by location, particularly with regard to storage at temporary job sites or away from 
your primary storage location such as hotels and motels and in vehicles.  You should contact 
your local Radiation Control Authority to identify the specific storage requirements in your 
jurisdiction.

Transportation

There are no X-ray tube specific US Department of Transportation (DOT) or International 
Air Transport Association (IATA) radiation regulations regarding shipping the Niton XL2 
Plus analyzer. It is recommended that you ship the analyzer in its carrying case and an 
over-pack to protect the sensitive measuring equipment inside the analyzer. Do NOT ship the 
analyzer with the battery pack connected to the analyzer.

Lost or Stolen Instrument
Note  THIS PAGE CONTAINS EMERGENCY CONTACT INFORMATION THAT 
SHOULD BE AVAILABLE TO THE OPERATOR AT ALL TIMES.

If the Niton XL2 Plus analyzer is lost or stolen, notify your Radiation Safety Officer (RSO) or 
the equivalent responsible individual at your company or institution immediately. Your 
company's RSO, as well as other important emergency contacts, are listed below. Your 
company RSO may need to notify the x-ray tube regulatory authority and the local police. It 
is also recommended that a notification is made to Thermo Fisher Scientific.

Connector Voltage Level Manufacturer and Part Number

USB port 5V Molex, 
56579-0576

Connector for Remote Trigger 3.3V CUI, 
SJ-3523-SMT-TR

Serial port 5V CUI, 
SJ-2523-SMT-TR

DC Power JACK
Use Power Supply 420-011

12V CUI, 
PJ-014CH-SMT-TR
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Damaged Instrument

Minor Damage

If the instrument is intact but there is indication of an unsafe condition such as a cracked case, 
a shutter mechanism failure, or the lights remain flashing after a measurement is terminated, 
follow these steps:

1. Stop using the instrument

2. Remove the battery. The x-ray tube can not produce radiation when the battery is 
disconnected. The instrument is now safe to handle.

3. Place the instrument securely in the holster.

4. Place the instrument in the carrying case that came with the instrument.

5. Notify your Radiation Safety Officer (RSO) or the equivalent responsible individual at 
your company or institution immediately.

6. You or your RSO should call Thermo Fisher Scientific at one of their contact numbers 
listed below for additional instructions and guidance.

Major Damage

If the instrument is severely damaged:

1. Perform the same steps as described above for minor damage. There will be no radiation 
hazard as long as the battery is removed from the instrument.

2. Place all components in a plastic bag and contact Thermo Fisher Scientific.

Battery Installation and Charging
Before installing your batteries for the first time in your system, please be sure that they are 
fully charged by following the procedure below.

CAUTION  The battery used in this device may present a risk of fire or chemical burn if 
mistreated. Do no disassemble, heat above 50C, or incinerate. Replace battery with Thermo 
Fisher Scientific P/N 420-002 only. Use of another battery may cause fire or explosion.

Dispose of used battery promptly. Keep away from children. Do not disassemble and do not 
dispose of in fire.

 To install the battery

1. Slide back the catch on the bottom of your analyzer’s pistol grip and drop the battery out 
into your hand.
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2. Place the old battery aside and slide the new battery up into the cavity in the bottom of 
the pistol grip. The battery is keyed, and will only insert fully one way.

3. Press in until the latch resets. Do not force the battery into the cavity.

Power Supply and Cable

A power cable and power supply and cable are provided to power the battery charger. Both are 
shown below, along with their part numbers.

 Recharging the battery pack

Fully recharging a battery pack takes approximately 2 hours.

1. Remove the battery pack from the analyzer.

2. Connect the power supply to the battery charger, and connect the power cable to an 
electrical outlet.

Power Cable PN 420-007 Power Supply PN 420-011
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3. Place the battery pack upside down into the charger. The battery pack is keyed, and will 
only fit into the charger fully one way. If your battery pack is resting on the back of the 
charger rather than sliding all the way to the bottom, remove the battery pack, turn it 
around, and re-insert it into the charger.

CAUTION  Do not force the battery into the charger!

4. The red light is on when the charger is plugged in. This is the power indicator light.

5. The yellow light indicates that the battery pack is currently being charged.

6. The green light indicates that the battery pack has finished charging and is ready for use.

Figure 6. Checking Battery Status

CAUTION  Do not store battery packs or charger in direct sunlight.

CAUTION  Do not let the battery pack recharge for excessive periods of time.

Battery charger power 
specification: 12vDC, 3 A

See battery charger “Power 
Supply PN 420-011” on page 24.
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Hot Swap Feature
Batteries for the XL2 Plus are designed to be hot-swappable. Capacitors in the unit maintain 
function of the instrument for 15 seconds after the batteries have been removed, so that a 
fresh battery can be substituted with no down time and reboot. 

Emergency Response Information
Please Complete the Following Emergency Response Information and Keep with the Analyzer 
at All Times

NITON ANALYZER EMERGENCY CONTACT INFORMATION

The Company RSO is:______________________________________

RSO Telephone Number:____________________________________

Regulatory Agency Emergency Number:________________________

Local Fire Department:______________________________________

Local or State Police Department:_____________________________

Thermo Fisher Scientific's Niton Analyzer Contact Numbers

Main Number (USA): (800) 875-1578

Additional Radiation Emergency #'s: (978) 790-8269 or (617) 901-3125

Outside the USA - Local Niton Service Center:___________________

Europe

Niton Analyzers Europe

Munich, Germany

Phone: +49 89 3681 380

Fax: +49 89 3681 3830

Email: niton.eur@thermofisher.com

Note  If you take more than 15 seconds to swap in a new battery, you may need to reboot 
the analyzer. Measurements cannot be initiated while instrument is in Hot Swap mode.   
Instrument must have a battery installed or must be plugged-in to a power source. 
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Emergency Response Information
Asia

Niton Analyzers Asia

Hong Kong

Phone: +852 2869-6669

Fax: +852 2869-6665

Email: niton.asia@thermofisher.com

Registration and Licensing

As a user of a Niton XL2 Plus analyzer, you may be required to register or obtain a license 
with your local radiation control authority. In the US, if you intend to do work with your 
analyzer in states other than your own, you may be required to register there as well. See the 
Safety and Compliance Web Hub for much more information.

Regarding Safety Devices for the Open Beam Configuration:

In the US, you may be required to file for an exemption, “variance letter”, with your state if 
there is a requirement for a safety device that would prevent entry of an extremity into the 
primary beam. If you need assistance with the exemption letter, you may contact the radiation 
safety group.
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4

Common Operations

Setting Up Beep Times
Beep times are a series of three beeps made by your analyzer at specified intervals during a 
reading. They can help you time your reading without watching the screen. You can disable 
these beeps, or change the default times.

Contents

• “Setting Up Beep Times” on page 29

• “Sorting the Custom Element Display” on page 30

• “Max Measure Time” on page 33

• “Minimum Test Time” on page 33

• “Virtual Keyboard” on page 34

• “Setting Display Units” on page 36

• “Adjusting the Element Range” on page 38

• “Setting the Date and Time” on page 40

• “Calibrating the Touch Screen” on page 42
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First Beep

This option allows you to change the seconds of delay before the First Beep. Select the screen 
button labeled with the number of seconds of delay for the First Beep. The Beep One Time 
editor will open. Clear the current number of seconds with the “C” button, then select the E 
button to enter the information.

Second Beep

This option allows you to change the seconds of delay before the Second Beep. Select the 
screen button labeled with the number of seconds of delay for the Second Beep. The Beep 
Two Time editor will open. Clear the current number of seconds with the “C” button, then 
select the E button to enter the information.

Third Beep

This option allows you to change the seconds of delay before the Third Beep. Select the screen 
button labeled with the number of seconds of delay for the Third Beep. The Beep Three Time 
editor will open. Clear the current number of seconds with the “C” button, then select the E 
button to enter the information.

Beep on Grade Match

Selecting this option will enable a special beep when the reading chemistry matches an alloy 
grade, and put a check mark in the box. Selecting the box again will remove the check mark 
and turn the beep off.

Sorting the Custom Element Display
Select the Custom Element Display icon to configure sorting criteria used for analysis display. 
Select the mode you wish to change, then selecting the Custom Element Display icon opens 
up the Custom Element Display Screen.
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Sorting the Custom Element Display
On the left of the display are elements, each with its currently selected display option beside it 
to the right. The element list is ranked by importance, with the most important element on 
top, and each one lower down of less importance than the one above it.

By selecting an element and using the arrow buttons to the right of the list, you can change its 
ranking. Use the Up Button to move an element one rank closer to the top with each click. 
Use the Down Arrow Button to move an element one rank closer to the bottom with each 
click.

Display Options

The Display Options Drop Down Menu allows you to change the display status of any 
element to one of three states:

• Normal - The standard state. Element displays only when the elemental value is 
greater than the limit of detection.

• Always display the results for this element. Use this state for elements critical to all of 
your analyses.

• Never display the results for this element. Use this state for elements which are 
unimportant to your work. This makes your instrument display less complex.
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Select the element you want to change, then select the menu option corresponding to your 
choice of display status. The currently selected element is displayed in white on black.

Select the Save Button to save your current status as the new default. Select the Reset button 
to reset the settings to the previously saved state. Select the Close button to exit the screen 
without saving.

Report Settings 

Under Electronics Metals, Plastics, and Test All Modes, A field called Report Settings is 
available. Selecting the triangle next to the Report Settings Field will open a pop up menu 
allowing you to choose between the three Report Settings Modes. Select the mode you wish to 
edit.

Changing the settings for one analysis mode will not affect the settings for other modes, and 
the configurations can be saved independently.

RoHS Option

When the RoHS Option is selected, clicking on the Pass and Fail values works as it does in 
any other Mode.

Detection Option

When the Detection Option is selected, Selecting the Pass/Fail field for that element acts as an 
On/Off Toggle, which will switch Pass/Fail mode between On and Off for the selected 
element. Selecting it again will reverse the toggle.
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Consumer Products Option

When the Consumer Products Option is selected, clicking on the Pass and Fail values works 
as it does in any other Mode. In addition, the total of Cl+Br is also calculated and used for 
Pass/Fail Testing.

Max Measure Time
Under the Method Setup -> Measurement Parameters option is a field called Max Measure 
Time. Here you can set up the maximum time your analyzer will continue to analyze the 
sample. Select the Max Measure Time field, and a Virtual Numeric Keypad will pop up, 
allowing you to input a new Maximum Measurement Time in seconds. The default Max 
Measure Time is set to 300 seconds.

Minimum Test Time
Under the Method Setup -> Consumer Goods option is a field called Minimum Test Time. 
Here you can set up the minimum time your analyzer will continue to analyze the sample 
when using the Detection Option only. Select the Minimum Test Time field, and a Virtual 
Numeric Keypad will pop up, allowing you to input a new Minimum Test Time in seconds. 
The default Minimum Test Time is set to 60 seconds.

• Minimum Test Time can be set for Test All, Plastic, and Metals & Ceramics.

• Minimum Test Time cannot be set for Painted Products.
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Virtual Keyboard
Whenever you see the Keyboard Icon, you can select it to bring up a Virtual Keyboard on 
your touch screen. Generally, selecting the keys on the Virtual Keyboard will type the 
corresponding character into the field. The exceptions are the meta-keys Del, Clear, Left, 
Right, Shift, Backspace, Cancel, and Enter. 

Figure 7. Virtual Keyboard

Keyboard 
icon
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Virtual Keyboard
Figure 8. Shifted Virtual Keyboard
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Setting Display Units 
Select the Display Units radio buttons on the Set Display Units page to choose between ppm 
(parts per million) and percentage (hundredths of whole) displays when taking readings, and 
to change the Sigma value you want for the reading. 

In the Display Units area, you can select between Percent composition and Parts per Million 
as the units displayed in a measurement, and you can change this setting independently for 
any mode. You can also change the Sigma for each of these modes independently. When you 
have changed the display units to the appropriate values, select the Close button to save these 
settings for use.

Changing Precision (Sigma Value)

Sigma is the symbol used for Standard Deviation, a measure of how much a set of numbers 
deviates from the mean. For example, each of the three data sets {0, 0, 14, and 14}, {0, 6, 8, 
and 14} and {6, 6, 8, 8} has a mean of 7. Their standard deviations are 7, 5, and 1, 
respectively. The third set has a much smaller standard deviation than the other two because 
its values are all close to 7. In a loose sense, the standard deviation tells us how far from the 
mean the data points tend to be. The number of standard deviations between the process 
mean and the nearest specification limit is given in sigmas. As process standard deviation goes 
up, or the mean of the process moves away from the center of the tolerance, the sigma number 
goes down, because fewer standard deviations will then fit between the mean and the nearest 
specification limit.

Confidence Intervals

Confidence intervals assume that the data are from an approximately normally distributed 
population - generally, sums of many independent, identically distributed random variables 
tend towards the normal distribution as a limit. Using this assumption, about 68 % of the 
values must be within 1 standard deviation of the mean, about 95 % of the values must be 
within two standard deviations, about 99.7 % must lie within 3 standard deviations, and 
about 99.99% of the values must lie within 4 standard deviations.

The greater the sigma value of the test, the more confident you can be that the sample is as it 
appears, but the more difficult and time consuming the testing must be to verify this. That's 
why it's important to use the most appropriate sigma value for the test. By adjusting the sigma 
value for each type of test, you can optimize the process for your needs.
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Adjusting the Sigma Values

The sigma values are listed in the column headed with the Greek letter “sigma”. The default 
value is 2 sigma. You can change this value by selecting the down arrow next to the value, 
which opens up a drop-down menu from which you can select the desired sigma value by 
clicking on it.

Figure 9. Selecting the Sigma Value

When you have changed the sigma values to the appropriate number, select the Close button 
to save these settings for use.
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Adjusting the Element Range

Figure 10. Adjusting the Element Range

Multi-Range tests are used to either preferentially excite specific elements for increased 
sensitivity, or to cover a wider element range than one Range alone can provide. The XL2 Plus 
analyzer is has 2 element ranges: Main and Light.

• Main Range is used for the analysis of most elements (Ti to U)

• Light Range is typically used for the analysis of light elements (Mg, Al, Si, S, P). 

Select the mode you wish to configure from the Mode Menu. You can set different 
configurations for different calibration modes.

The Element Range Screen enables you to directly enable or disable a Range, or control the 
time that a Range alters the irradiation of the sample before auto-switching to another Range.

In typical metals analysis applications, Main Range is used for the analysis of most elements. 
You cannot deselect the Main Range in metals analysis.
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Adjusting the Element Range
Select the Element List Button - labeled with a question mark - to display the Element List for 
that Range. This list shows the elements that the Range is best designed to detect.

Select the Range Time field for the intended range to change the switch time for that range. 
The Range Time Editor will appear. This enables you to set the number of seconds each 
enabled range is allotted before auto-switching will occur when needed during sample testing. 
Your analyzer will auto-switch from one range to another when the testing time for that range 
is greater than or equal to the time you have chosen, and the identified alloy is flagged as 
needing the switch in the Niton Alloy Library.

Select the C button to clear the current time, then from the virtual numeric key pad, select 
each digit you want to input, then select the E button to enter.
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Setting the Date and Time

Figure 11. Setting the Date and Time

From the System Menu, select the Date & Time icon from the System Screen to set the date 
and time as needed for different time zones, daylight savings time, or any other reason. The 
date and time are factory preset prior to shipping. The clock is a 24 hour clock, so add 12 to 
PM hours - i.e. 1:13 PM would be 13:13.
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Setting the Date and Time
Figure 12. The Date & Time Screen

When the Date & Time button is selected, the Date & Time Screen comes up on your 
analyzer’s LCD Screen. You may change the Month, Year, Date, Hour, and Minute on your 
analyzer.
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Calibrating the Touch Screen

Figure 13. Initiating Touch Screen Calibration

Proper calibration of the touch screen to the display is important for touch accuracy. If you 
find the touch screen does not respond to the buttons you touch, you should re-calibrate it. 

Select the Calibrate Touch Screen button from the System Screen to re-calibrate the analyzer's 
touch screen display. This procedure establishes the display boundaries for the touch screen 
interface.

1. Select the Touch Screen icon.

2. The display will show a message asking you to confirm whether or not you want to 
calibrate your Touch Screen. Select the Yes button.

3. The display will show the message: “Calibrate Touch Screen”. There will be a small cross in 
the upper left-hand corner of the display.

4. Tap on this cross with the stylus, and the cross will disappear and reappear in the upper 
right-hand corner of the screen.

5. Tap on the cross again, and it will reappear in the lower right-hand corner of the screen.

6. Tap on the cross again and it will reappear in the lower left-hand corner of the screen.

7. Tap on the cross once more, and you will be presented with a Confirmation Screen.
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8. Select the Yes Button to confirm that the parameters are good. Select the No Button to start 
the process again.

9. Once you have confirmed the parameters, the System Menu will be displayed. The screen is 
now calibrated.

Figure 14. Touch Screen Calibration Crosses

The Touch Screen can be calibrated - and the system operated - with a USB mouse plugged 
into the USB ports in the rear of the analyzer.
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Analysis Modes

Analysis Modes Descriptions
Your analyzer has several Analysis Modes. Which Analysis Mode you should use depends on 
the nature of the sample you analyze. 

NOTE: Visit https://portables.thermoscientific.com/ to get Standard Operating Procedures 
(SOP) for each calibration mode. In this chapter, an SOP in included for General Metals as an 
example.

General Metals Mode 

Use this mode to analyze typical alloys, such as iron (Fe), nickel (Ni), cobalt (Co), chromium 
(Cr), aluminum (Al), titanium (Ti), copper (Cu) and zinc (Zn) base metals. This is the ideal 
mode for any general metals analysis, such as PMI, incoming / outgoing inspections, QA / 
QC, and scrap metal sorting. This mode includes most common alloying constituents. 

This mode will attempt to return an Alloy Grade Identification by matching the analyzed 
composition of the sample with the nominal composition of alloys in the analyzer's Alloy 
Grade Library. It will also return an elemental composition of the alloy as analyzed. Alloy 
Composition is output by default in terms of percent of composition by weight. 

Contents

• “Analysis Modes Descriptions” on page 45

• “Metals Analysis” on page 48

• “General Metals: Standard Operating Procedure” on page 50

• “Taking a General Metals Reading” on page 53

• “Precious Metals Analysis” on page 55
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Electronic Metals Mode

Use this mode to analyze metal samples typically found in electronic goods (such as printed 
circuit boards PCBs, wires and other manufactured components). This mode includes many 
common alloying constituents plus some elements used for bonding and soldering (such as Au 
and In). 

This mode will attempt to return an Alloy Grade Identification by matching the analyzed 
composition of the sample with the nominal composition of electronic alloys in the analyzer's 
Alloy Grade Library. It will also return an elemental composition of the electronic alloy as 
analyzed. Electronic Metal Composition is output by default in terms of percent of 
composition by weight.

Precious Metals Mode

Use this mode to analyze precious alloys such as those found in jewelry, gold and silver coins, 
and archaeological and historical samples.This mode will attempt to return an Alloy Grade 
Identification by matching the analyzed composition of the sample with the nominal 
composition of alloys in the analyzer's Precious Alloy Grade Library. It will also return an 
elemental composition of the precious metal sample as analyzed. Precious Alloy Composition 
is output by default in terms of percent (%) per million. 

Metal Coatings Mode

Use this mode for the determination of the thickness of 1 to 3 layers (coatings) on a metal 
substrate. For example, this mode may be used for the analysis of the thickness of a coated 
surface to ensure the material is plated consistently, or to determine that a conversion coating 
is of sufficient thickness. This mode does not determine the chemical composition of the 
sample. 

Metals Pass/Fail Mode

Use this mode to select alloys from an XL2 Plus Library, which are tested to meet Pass/Fail 
criteria during a reading.

Plastics Mode

Use this mode to analyze samples composed primarily of plastic. This mode will return an 
elemental composition of the plastic sample as analyzed. Plastic Composition is output by 
default in terms of parts per million.
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Soils Mode

Use this mode to analyze samples composed primarily of soil and rock. This mode will return 
an elemental composition of the soil sample as analyzed. Soil Composition is output by 
default in terms of parts per million.

Mining Cu/Zn Mode

Use this mode to analyze samples composed of potential metal ore - rock containing high 
proportions of metal - and containing Cu and/or Zn. This mode will return an elemental 
composition of the ore sample as analyzed. Ore Composition is output by default in terms of 
percent of composition by weight.

Mining Ta/Hf Mode

Use this mode to analyze samples composed of potential metal ore - rock containing high 
proportions of metal - and containing Ta and/or Hf. This mode will return an elemental 
composition of the ore sample as analyzed. Ore Composition is output by default in terms of 
percent of composition by weight.

TestAll Mode 

Use this mode to analyze samples composed of unknown and/or mixed composition, such as 
toys and consumer products. This mode will attempt to return a general Material 
Identification by comparing the analysis with other general types of materials. It will select the 
proper sub-mode for analysis and return an elemental composition of the sample as analyzed. 
Material Elemental Composition is output by default in terms of parts per million.

TestAll Geo Mode

Use this mode to analyze powder, mineral, and ore samples without first determining whether 
the samples would best be analyzed with Mining or Soil Mode. This mode uses both the 
Compton Normalization calibration (Soil) and the Fundamental Parameters calibration 
(Mining) to determine whether the soil calibration is acceptable or whether the total metal 
content is too high for Compton mode. It will then return an elemental composition of the 
sample as analyzed. If the sample can be analyzed via soil mode, then the analyzer will display 
results from both Soil and Mining Modes in one unified list. If both calibrations contain the 
same element, then the mode that has the lower detection limit will be displayed. Material 
Elemental Composition is output by default in terms of  both parts per million (mg/kg) and 
percent of composition by weight, with 0.10% being the cutoff point. 

Note  Due to the nature of this mode, your analyzer will only use factory calibrations. User 
modified Cal Factors will not be available.
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Metals Analysis
To analyze metal samples, from the main menu select sample type, and then click on the 
Metals icon. Once in the Metals Selection Screen there will be 1 to 5 Metals Calibration 
Modes (depending on the model number and on optional calibrations purchased).

Figure 15. The Metals Analysis Menu Path (Main)
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Element Ranges and Lists

From the Element Range Screen, select the Element List Button to display the Element List 
for the Range you want to use. This list shows the elements that the Range is best designed to 
detect. See “Adjusting the Element Range” on page 66. for details.

Figure 16. The Element Range Menu Path

Element List 
buttons
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General Metals: Standard Operating Procedure
NOTE - Each user should read this User’s Guide carefully before initiating measurements 
with the system. Users are strongly urged to attend the Thermo Scientific Niton XRF 
Analyzer Radiation Safety and Operations Training courses offered regularly, or the web-based 
trainings. For more information, visit https://portables.thermoscientific.com/.

Preparatory Tasks

1. Attach a charged battery to the analyzer and turn it on. Follow the screen instructions and 
“Log On” as the operator using either the default password or a custom one as designated 
by the user in an NDU file.

2. Verify that the date is set properly for data tracking purposes.

From the Main Menu, select the System icon, then the Specs icon. The date will be 
displayed for verification. If the date is incorrect, correct it prior to proceeding. This can 
be done by “Closing” out of the Specs screen and selecting the Date & Time icon. 
Detailed information on this procedure is available in Setting the Date and Time.

3. (Optional) Connect the analyzer to a computer via the included USB cable. (Consult 
“Using a USB Cable to Connect Your Analyzer” on page 136 if necessary.)

4. During analysis and detector calibrations, it is important to ensure that the analyzer is not 
exposed to strong electromagnetic fields, including those produced by computer 
monitors, hard drives, cellular telephones, walkie talkies, etc. Keep a minimum two (2) 
feet (0.7 meters) distance between the analyzer and electronic devices.

5. From the Main Menu, select System Check icon then the Yes button. 

a. System Check calibrates the detector and verifies it is operating to specifications. 
After starting the process, no further user interaction is required during this 
operation. When the instrument is finished performing the check, the unit will show 
either “System OK” or one of the failure errors.
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b. If the unit shows a failure error, then perform a second System Check by clicking 
Recheck. If the unit still does not show a “System OK,” please contact Thermo 
Scientific. See “Contact Us” on page 1.

6. Thermo Scientific Niton XL2 Plus analyzers are equipped with excitation filters that 
optimize the analyzers’ sensitivity for various elements. The “Main Range” filter provides 
optimum sensitivity for the elements titanium (Ti) through uranium (U). The “Light 
Range” filter is used to optimize sensitivity of light elements, magnesium (Mg), 
aluminum (Al), silicon (Si), phosphorus (P) and sulfur (S). The amount of time that the 
analyzer spends in each filter position is user definable, but the default settings should be 
used unless there is reason to change them. Please note that the analyzer will continue 
alternating excitation filters until the user selectable maximum analysis time is reached or 
the operator terminates the measurement.

Verify Accuracy

Verify instrument measurement accuracy using the 2 reference materials (RM) supplied with 
the analyzer. 

1) Reference material (1.25Cr 0.5Mo). Test this sample for 30 sec on main range filter only

2) Al 6061 check sample. Test 5 sec on main range and 30 sec on light range filters.

If the sample is correctly identified and all major elements read within calculated acceptance 
limits (within the low and high values of factory readings found on the QC sheet, proceed to 
General Testing Protocol section

If the analyzer reports values outside the acceptance tolerance ranges specified in the tables, 
repeat the detector calibration then repeat the reference sample analysis.

If the analyzer again fails to meet the acceptance tolerance ranges specified in the tables, please 
contact Customer Support. See “Contact Us” on page 1.
Thermo Scientific Niton XL2 Plus User’s Guide 51



5 Analysis Modes
General Metals: Standard Operating Procedure
General Testing Protocol

Good surface preparation is essential for obtaining accurate test results. All non- representative 
material (e.g., paint, coating, scale) must be removed prior to testing. An approximately 
2-inch-square section of surface should be cleaned down to the material to be analyzed. See 
sample preparation section under each of the analysis modes, where applicable.

The analyzer will often display a correct alloy identification and/or accurate chemistry result 
before the specified time interval. If the accuracy meets the user’s requirements, it is not 
necessary to measure for the full time. Longer measurements might be necessary if low 
concentrations of elements must be determined. 

INSTRUMENT QC

Measure the supplied reference calibration check sample AT LEAST once a shift. If correct, 
continue work. If incorrect, redo System Check and re-take the past 2 hours of results.

Undersized or Non-Contact Samples 

(Samples that do not make contact with or that do not fully cover the measurement aperture)

For samples that do not fully cover the measurement aperture, increase the testing time by 
increasing the time in inverse proportion to the decrease in percentage of aperture covered. 
For example: a rod only covers ½ of the aperture, so increase the measurement time by two 
(e.g., from 10 to 20 seconds per filter for alloy chemistry).

The best procedure to measure undersized samples is to use the Thermo Scientific Niton 
portable test stand (optional), which is shielded to prevent radiation exposure to the operator.

An undersized sample may alternately be measured while lying on another material. Results 
may be affected by the signal coming from the underlying material itself. Use only pure 
aluminum, pure plastic, or clean wood and employ the Disable Al feature. Use the Tools 
Menu, then select Disable Al, and check the underlying surface itself to be sure no metals are 
present. Be sure to use the Tools Menu and select Enable Al before testing aluminum alloys.
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Taking a General Metals Reading
The following example is for taking a General Metals reading.

1. Clean the sample to be analyzed so it is free of all surface contamination.

2. Place the analyzer so the sample is covered by the analysis window.

3. Select the Sample Type Icon. 

4. Select Metals > General Metals from the Mode Menu.
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5. Select the Analyze Icon.

The Ready to Test screen displays

a. The Info screen lists the current mode and library being used, plus configuration 
info.

b. Select Data Entry if you wish to do any data entry.

c. Select Tools to configure or customize the mode.

d.

6. Initiate a Reading by pressing the trigger.
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7. When the sample has been sufficiently analyzed, release the trigger.

8. View the composition returned.

Precious Metals Analysis
See “Preparatory Tasks” on page 50 for a full range of tasks performed using a Standard 
Operating Procedure. Then use the steps below to verify the instrument

1. Verify instrument measurement accuracy using the reference material (RM) supplied with 
the analyzer, if one is supplied.

2. Test the factory-supplied standard (or other approved check sample) based on a 30s 
measurement. If the sample is correctly identified and all major elements read within 
calculated acceptance limits (within the low and high values of factory readings found on 
QC sheet), proceed to General Testing Protocol section

3. If the analyzer reports values outside the acceptance tolerance ranges specified in the 
tables, repeat the detector calibration described in step 7, then repeat the reference sample 
analysis in step 8.1

4. If the analyzer again fails to meet the acceptance tolerance ranges specified in the tables, 
please contact Thermo Scientific Portable Analytical Instruments Inc., or your local 
representative for assistance.
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Using the Precious Metals Mode

This is a guide to using the Precious Metals Mode.

Figure 17. Precious Metals Mode Menu Path

Select the Sample Type icon from the Main menu, then the Metals icon, then the Precious 
Metals icon to enter Precious Metals Mode.
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Figure 18. Precious Metals Mode Ready To Test Screen

When testing metals with Au in their composition, Precious Metal Analysis returns the 
metal's Karat rating.

Note - in order to use the Karat analysis with the Niton XL2 Plus analyzers, you need to set up 
Karat as a pseudo-element first. 

Figure 19. Precious Metals Analysis of 24 Karat Gold Showing Karat Rating

When testing metals with no Au in their composition, Precious Metal Analysis returns the 
metal's Karat rating as nd (Not Detected).
Thermo Scientific Niton XL2 Plus User’s Guide 57



5 Analysis Modes
Precious Metals Analysis
Figure 20. Precious Metals Analysis Showing Nd Karat Rating

When testing metals with Au present, Precious Metal Analysis returns the metal's Karat rating 
as rounded to the nearest Karat at the top of the list. Where the Au is listed on the Complete 
List of elements, the Karat rating is displayed in full. 

Figure 21. Precious Metals Analysis Showing Fractional Karat Rating

AuDIT TM

The AuDIT algorithm determines whether or not a surface is plated. AuDIT can detect 
plating as thick as 8um. Since most plating is less than 2-3um, this can usually detect plated 
objects. Heavily plated objects with a plating greater than 8um thick will read as Gold Plate 
Not Detected.
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Starting/Stopping AuDIT

AuDIT can be toggled on or off from your Tools Menu. This toggle is only available in 
Precious Metals Mode. Selecting the AuDIT:Off button will turn AuDIT on, and change the 
button to “AuDIT:On”. Selecting the AuDIT:On button will turn AuDIT off, and change the 
button to “AuDIT:Off”.

Figure 22. Precious Metals Tools Showing AuDIT:Off and AuDIT:On Buttons

AuDIT uses four separate tests run automatically to determine whether or not a sample is 
plated.

1. The first test is a patent-pending method only available on Thermo Scientific Niton XRF 
analyzers. This is an iterative comparison of x-ray intensity signatures, which, when it fails, is 
the most likely indication of a plated item.

2. Nickel is often used as a pre-plate, and high proportions of Ni in a reading are a good 
indicator of plating.

3. Platings often have a low Karat value when averaged with the substrate, so Karat values of 
less than 9 are flags indicating plating.

4. A Karat rating that is not one of the standard Karat percentages - within 0.5 karat of 9kt, 
10kt, 14kt, 18kt, 22kt, or 24kt (referred to as Out of Plumb) - also may indicate the presence 
of plating.
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Figure 23. Precious Metals Analysis Showing Four AuDIT Tests

Only if the sample passes all four tests is it labeled “Gold Plate Not Detected”. This does not 
mean that there is no plating, but that the presence or absence of plating cannot be 
determined by the analyzer.

Additional Methods of Plating Detection

Analyze the item in several different areas

Variance of more than 1-2% in Au content can be a positive indication that an item is 
plated.

Look for identifying marks (hallmarks)

Compare to your results. Discrepancies may indicate that an item is plated.

Note: You may come across some Italian jewelry that has 18k gold plating over 14k gold. 
This is hallmarked as 14k or 585, but will likely show 16-17k on XRF.

“Smell” the item

A metallic, copper-like smell (similar to copper-based coins such as USA pennies) 
indicates the possible presence of a copper substrate under gold plating.

Use a strong magnet

A magnetic draw on the item may indicate a magnetic substrate under gold plating (gold 
alloys are not magnetic).

As a final and last resort…

analyze a spot, perform a deep file or grind, and then analyze the same spot again. A 
reduced gold content (more than 1-2%) indicates a thinning of the gold plating layer.
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AuDIT Messages

Figure 24. Precious Metals Analysis Showing AuDIT Disabled

If AuDIT is not enabled, a white on black message stating “AuDIT Disabled” will display on 
the Results Screen while in Precious Metals Mode.

Figure 25. Precious Metals Analysis Showing Probable Plating

If AuDIT detects what looks like gold plating on the material, a black on red message stating 
“Gold Plate Probable” will display on the Results Screen.
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Figure 26. Precious Metals Analysis Showing Suspected Plating

If AuDIT detects what may be gold plate, but isn't sure, a black on yellow message stating 
“Gold Plate Suspect” will display on the Results Screen.

Figure 27. Precious Metals Analysis Showing No/Thick Plating

If AuDIT detects what is either unplated gold or very thickly plated gold, a black on white 
message stating “Gold Plate Not Detected” will display on the Results Screen.
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Figure 28. Precious Metals Analysis Showing High Ni Content

If AuDIT finds too much Nickel in the sample, a black on yellow message stating “High Ni 
Content” will display on the Results Screen.

Figure 29. Precious Metals Analysis Showing Low Karat

When AuDIT finds a Karat rating less than 8.5 Karat in the sample, a black on yellow 
message stating “Low Karat” will display on the results Screen.
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Figure 30. Precious Metals Analysis Showing Non Standard Karat

When AuDIT finds a Karat rating other than the standard Karats, a black on yellow message 
stating “Non-Standard Karat” will display on the results Screen.
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Contents

• “Adjusting the Element Range” on page 66

• “Tools Menu Options” on page 72

• “NDF Files: User Data Structuring” on page 93

• “Safety Settings” on page 105

• “Camera” on page 111
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Adjusting the Element Range

   

Figure 31.      The Range Menu Path (Main)

Multi-Range tests are used to either preferentially excite specific elements for increased 
sensitivity, or to cover a wider element range than one Range alone can provide. Most modes, 
when enabled, will use two Ranges in sequence to produce a combined analysis result. In 
typical alloy analysis applications, Main Range is used for the analysis of most elements, Low 
Range is utilized for the subsequent high sensitivity analysis of V, Ti, and Cr, and Light Range 
is available only with 900 series GOLDD technology analyzers, and is typically used in light 
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element analysis. Multi-Range switching can be set to activate off time alone, or, when time 
switching is disabled, off settings in the General Metals grade library. In most modes, Low and 
Light Range add the capability to analyze light elements which cannot be efficiently excited by 
Mid Range.

Figure 32.    Selecting the Mode

Select the mode you wish to configure. You can set different configurations for different 
modes.

The Element Range Screen enables you to directly enable or disable any Range, or control the 
time that a Range alters the irradiation of the sample before auto-switching to another Range.
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Figure 33.    The Element Checkboxes

Select the checkbox next to the Range you want to use to determine exactly which of the 
Ranges contained in your Analyzer is used for sample testing. Selecting an empty checkbox 
will enable that range and place a check into the box as an indicator. Selecting a checked box 
will disable the Range and clear the box.

In typical alloy analysis applications, Main Range is used for the analysis of most elements. 
You cannot deselect the Main Range in alloy analysis

Low Range is utilized for the subsequent high sensitivity analysis of V, Ti, and Cr.
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Figure 34.    The Range Element Lists

Select the Element List Button to display the Element List for that Range. This list shows the 
elements that the Range is best designed to detect.
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Figure 35.    The Range Time Fields

Select the Range Time field for the intended range to change the switch time for that range. 
The Range Time Editor will appear. This enables you to set the number of seconds each 
enabled range is allotted before auto-switching will occur when needed during sample testing. 
Your analyzer will auto-switch from one range to another when the testing time for that range 
is greater than or equal to the time you have chosen, and the identified alloy is flagged as 
needing the switch in the Niton Alloy Library.
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Figure 36.    The Range Time Editor

Select the C button to clear the current time, then from the virtual numeric key pad, select 
each digit you want to input, then select the E button to enter.
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Tools Menu Options
The following options can be performed from the Tools Menu. Options which are only on 
the main Tools Menu are listed as (Main). Those which can be found only on the alternate 
Tools Menu are listed as (Alt).

• Main Tools menu: from home screen select Sample Type > General Metals (or any mode)

• Alternate Tools menu: from a reading screen select Tools. 

Avg Forward

Enables you to average different readings together from this analysis forward. Select the Avg 
Forward button to initiate future sample averaging. Avg Forward will set up an automatic 
personal averaging protocol to be followed until your analyzer is shut down, or this feature is 
disabled. To begin, select the number of readings you want to average from the virtual 
numeric keypad. Your analyzer will calculate an average reading after that number of tests, and 
continue this pattern until stopped. If you select to average forward 3 readings, and you take 3 
readings, the analyzer will store the individual readings. Analyzer will then automatically 
calculate the average of the 3 readings and store an averaged reading. 

The maximum number of readings for average forward function is 99.

Main Tools 
menu

Alternate 
Tools menu
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Figure 37.      Example Averaging Screens

Avg Back (Alt)
Note  The alternate Tools Menu is only available when viewing readings, and the menu is only 
accessible through the touch screen interface or NDTr.
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Enables you to average different readings together from this analysis backward. Select the Avg 
Back option to initiate backwards sample averaging. Avg Back will take the number of 
readings you select and average their analytical results. The range is counted from the last 
reading backward by the number of readings selected. If your last reading was #15, selecting 3 
would average readings #13, 14, and 15. The average is calculated, displayed, and stored into 
memory as the next sequential reading number, in this case, #16.

The maximum number of readings for average forward function is 99. 

Note  You cannot average readings taken in different modes. Doing this will generate an error. 

Figure 38.      The Virtual Numeric Keypad

Spectrum:On/Spectrum:Off

The Tools Menu contains a toggle option to display live spectra as sample analysis occurs.
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Figure 39.      Example Analysis Screen Showing Live Spectrum

Print (Alt)

Select the Print option from the Tools Menu to print the current analysis screen to any 
attached Bluetooth printer. If you do not have a portable printer attached to your analyzer, 
nothing will happen.

Set Pass/Fail

You can set up your analyzer to sort on a pass/fail basis. Pass/Fail uses the chemistry of a 
user-generated list of alloys in the library as a basis for comparison. If the sample analysis is 
entirely within the specifications for one of these alloys, a PASS result is given, otherwise a 
FAIL result is returned. To turn on Pass/Fail, select the Tools Menu and select Set Pass/Fail 
from the menu. The Pass/Fail Setup Screen will come up.
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Figure 40.      Set Pass/Fail Screen

Add/Remove (Toggle)

Select alloys from the Available list and then the Add Button to move the alloy to the Selected 
List. Select alloys from the Selected list and then the Remove Button to remove the alloys 
from the Selected List.

Pass

Select the Pass Single button to initiate Pass Mode. Use Pass Mode when you have a desirable 
match. If the alloy being analyzed matches one of the alloys in the selected list, the alloy will 
Pass the analysis.

Fail 

Select the Fail button to initiate Fail Mode. Use Fail Single Mode when you have an 
undesirable match. If the alloy being analyzed matches one of the alloys in the selected list, the 
alloy will Fail the analysis.

Setting the Reference Alloys for Pass or Fail

Before you use Pass or Fail mode, you need to set the Reference Alloys. Select the alloy or 
alloys from the slide down menu on the Pass Fail Setup Screen, then select the Add button.
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Figure 41. .      The Pass Fail Setup Screen

Searching for Reference Alloys

Select the Search button to search the library for the alloy you want as your Reference Alloy. 

Figure 42.      Using the Search Function

Type the name of your reference alloy into the Virtual Keyboard, and the left column will 
display any matches. Select the match you want and the Add button to make it your reference 
alloy.
Thermo Scientific Niton XL2 Plus User’s Guide 77



6 Advanced Settings
Tools Menu Options
How Pass/Fail Works

To reach Metals Pass/Fail go to Home screen > Sample Type > Metals > Metals Pass/Fail.

Pass/Fail compares the chemistry to that of the alloy(s) selected, using the cutoff you selected. 
When the sample analysis reaches a match with the chemistry of any one of the alloys on the 
Selected list, a PASS or FAIL notice is generated as appropriate.

Figure 43. Metals Pass and Fail Screens

Alloy Display

The Alloy Display selection allows you to display the number of alloy library matches 
displayed during analysis and in readings.

• Hide Alloy Matches - displays no match at all

• Show 1st Match - displays the best alloy match

• Show 1st & 2nd Matches - displays the 2nd alloy match when the match quality between 
the 2 alloys is close in value

 To set alloy display

1. Select a mode to edit.

2. Select Tools from the Ready to Test screen.

3. Select Alloy Display, then choose a display setting.
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4. Save your changes.

The alloy display can also be changed after a reading completes. 

Match Quality

When Alloy Display is set to show matches, the match quality is color coded as shown below.

Switch Library (Main)

Switch Library is available only on General Metals mode. There are 2 libraries: 800 Alloy 
Library and 900 Alloy Library.

Enable/Disable Al

Normally, the collective amount of unquantifiable light elements in alloy analysis - the 
“balance” - is assumed to be aluminum and labeled as such in the analysis. Selecting the 
Disable Al button from the Tools Menu will delete this “aluminum” from the analysis results, 
showing only the quantified elements. Selecting the Enable Al button, the default state, will 
label this “balance” as “aluminum”.
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Thickness Correction

Thickness Correction is used only in Plastics mode. Plastics, and polymers in general, unlike 
metals or soil, are very weak absorbers of X rays. This is because polymers are composed 
mainly of very light elements such as carbon and hydrogen. While just half a millimeter of 
steel will completely stop 23.1 keV energy X rays of cadmium, for example, it takes at least 
10mm of plasticized PVC and as much as 100mm of polyethylene (PE) to do so. Fortunately, 
polymers that may contain cadmium (Cd), lead (Pb) and other restricted elements would also 
contain considerable quantity of elements such as antimony (Sb), bromine (Br), titanium 
(Ti), etc. Their presence results in much stronger absorption of X rays which means that, 
instead of 100mm, it takes only about 15mm of compounded PE to achieve saturation 
thickness for these X rays. If the thickness of analyzed polymer sample is less than 5mm for 
PVC or less than about 9mm for a “typical” PE, the measured intensity of X rays will be a 
function of both analyte concentration and sample thickness. This is why measurements 
performed on thin samples (less than saturation thickness) need to be corrected for thickness.

How to apply Thickness Correction.

In order for the instrument to apply thickness correction to the measured concentration 
results, the user must be using the Thickness Correction screen and enter the thickness of the 
analyzed plastic object expressed in [mm] before the measurement is initiated. The thickness 
may be entered with precision to the second decimal place, although in practice only one 
decimal place is sufficient for effective correction.
80 Niton XL2 Plus User’s Guide Thermo Scientific



 6 Advanced Settings
Tools Menu Options
Figure 44.      How to Enable and Adjust Thickness Correction for Plastics Analysis
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When to use Thickness Correction

Thickness Correction should only be used during the analysis of plastic (polymer) objects. It 
has been experimentally verified that the correction algorithm will yield satisfactory results, 
for a 60 second minimum testing time, for samples as thin as 0.3mm. Nevertheless, the 
recommended range of use of the correction is from 1mm upwards. It is imperative that this 
correction is not used for thin films such as single foils and plastic membranes; analysis of thin 
films is performed using the Thin Sample Mode. Contact Thermo Scientific or your local 
Niton Analyzers representative for information on this testing mode.)

Whenever possible, one should analyze as thick a sample as available. For example, if the 
analyzed object is a piece of heat-shrink tubing with wall thickness of 0.3mm, the best way to 
analyze it is to obtain several pieces of the tubing (four for example) and stack them like a flat 
sandwich, with the thickness correction set to 1.2mm. Doing so makes for faster and more 
precise analyses. While it would be possible to analyze just a single layer of the tubing with 
correction at 0.3 mm, by stacking several layers we reduce the relative error of measurement 
(by a factor approximately equal to the square root of the number of layers). Conversely, when 
analyzing thinner samples, we need to extend the measurement time fourfold (by the number 
of layers) in order to maintain the same relative error of measurement. We can see how 
quickly measurement time would escalate to impractical levels for thinner samples.

Examples: The most frequent instances in which thickness correction would be called for are 
analyses of plastic sheeting or plastic insulation on wires and/or cables and heat shrink tubing. 
Flat plastic sheeting or plastic enclosures pose no problems. We can either analyze an object 
“as is”, or stack several layers of it before analysis. Plastic insulation such as that on wiring or 
cables requires a little more sophisticated approach. First, the wire must be removed so that 
only insulation is analyzed. Then, the insulation should be flattened for analysis, and a 
thickness correction should be applied that is equal to double the wall thickness. Alternatively, 
if the insulation is stiff, it should be cut lengthwise into strands which are placed on the 
instrument for analysis. The applied thickness correction should be equal to the wall thickness 
of the sleeve. Both operations are shown in Figure 37 and Figure 38.

Figure 45.      Wire Insulation Cut Into Strands
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Figure 46.      PVC Wire Insulation With Conductor Removed

A piece of large diameter heat shrink tubing presents an interesting case. It is tempting to 
analyze this object as is - see Figure 39. However, one needs to know that while lead or 
bromine or chromium X-rays from the upper wall of tubing will not contribute to the signal 
measured, X rays of such elements as cadmium, antimony, tin or barium in the upper wall will 
significantly contribute to overall signal. It is therefore imperative to either flatten the tubing 
for analysis or cut it in pieces and then analyze as shown in Figure 40.

Figure 47. .      Incorrect Way to Measure Heat Shrink Tubing

Figure 48. .      Correct Way to Measure Heat Shrink Tubing
WARNING  Thickness correction is only for use with plastic/polymer samples. 
Thermo Scientific Niton XL2 Plus User’s Guide 83



6 Advanced Settings
Tools Menu Options
Enable/Disable Paint

Selecting the Enable Paint option from the Tools Menu will enable the Painted Products 
mode and toggle the option to Disable Paint. Selecting the Disable Paint option will disable 
Painted Products mode and toggle the option to Enable Paint.

Action Level

Action Level is available only from the Lead Paint modes. Selecting the Action Level option 
from the Tools Menu will enable you to change the action level used for qualitative testing.

Print Data

Selecting the Print Data option from the Tools Menu will print the currently displayed data to 
the optional attached printer. See “Print (Alt)” on page 75 for details.

Coatings Method

Metals are sometimes coated with various materials. If you wish to analyze the coating, select 
the Coatings Method. Coatings Analysis Mode is an optional mode which can be purchased 
and added to your analyzer.
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Passwords and User Privileges

For a list of user privileges see the screen in Figure 56. Install the latest version of Niton 
software (NDT) on your PC, if possible. You may obtain the latest version of NDT by 
contacting service at 800-875-1578.

1.  You can check the version number by opening NDT, selecting the Help menu, then 
selecting “About Niton Data Transfer”

Figure 49.     Selecting Help

2.   Select the File menu

Figure 50.    Selecting File

3.  Select “New” then “New Password File”. Your screen should look like this:
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Figure 51.     Creating the Security Key

4.  Create a unique security key, then select the OK Button

Figure 52.     Security Key

5.  Your screen should look like this:
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Figure 53.     User Account Creation Screen

6.  Right click, then select “New User”

Figure 54.     User Creation Dialog Box
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7.  Enter a user name and password, then select the privileges assigned to this user. Selecting 
the Check All check box will result in enabling all features.

Figure 55. .      Creating a User
WARNING  it is recommended that only users at the highest level have access to the “Safety” 
feature. This should be unchecked for all other operators.
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Figure 56.     Unchecking Safety

8. Select the Update Button

Figure 57.     User is Created

a. You are now ready to upload your password file to the analyzer.
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9.   Be sure the analyzer is switched on; connect the analyzer using USB or serial connection.

10.   Select the Upload icon.

Figure 58.     Selecting Upload

11.  Your screen should look like this:
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Figure 59.     Selecting Upload

12.  Select the Settings Button and choose the comm port that your analyzer is connect to.

13.  Select the Connect Button, then the Upload Button.

14.  Upon completion, you will receive a “File Upload Successfully Completed” message.

15.  Click the OK Button; save your password file at this time by selecting the File icon then 
“Save As.
Thermo Scientific Niton XL2 Plus User’s Guide 91



6 Advanced Settings
Tools Menu Options
Figure 60.     Successful Installation Message

16.  Restart your analyzer; your password file should be successfully installed.
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NDF Files: User Data Structuring

Creating New User-Defined Fields

You can create your own data entry fields for your Niton analyzer customized to your own 
needs and usage. These fields are saved in a special format called an NDF (Niton Data File) 
file. To create a new NDF file, select the File menu, then select New, then select New NDF 
File.

Figure 61. Creating a New NDF File

This will create a new window in which you can create your own fields, and specify their 
structure and parameters. The new window will appear with a single box, called “Untitled.”
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Figure 62. NDF File Work Area

By right-clicking on this box, you can access a pop-up menu allowing you to set the mode of 
the new data fields. Select New Mode to access the menu.

Figure 63. Selecting New Mode

The Mode you select will be the Mode within which the new data entry fields will appear. If 
you have multiple Modes enabled on your analyzer, the new fields will only be available from 
the Mode you select. Only the default fields will be available from the other Mode or Modes.
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Figure 64. Selecting Mode

When you select the Mode for the new data fields, the Construction Window will change to 
look like this:

Figure 65. Working within a Mode

The “M” indicates the mode you have chosen - in this case Alloy Mode. Right click on the 
Mode name to access a pop-up menu.
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Figure 66. Mode Pop-Up Menu

Select New Field from the menu, and a blank new field will appear in the construction 
window.

Figure 67. Adding a New Field

Right clicking on the New Field box will bring up another pop-up menu. This menu gives 
you various options for using the field in your operations.

Selecting Required makes it mandatory that the new field be filled in prior to taking a 
measurement. This is very useful for necessary descriptors which vary from measurement to 
measurement, such as lot numbers, condition descriptors, locations, etc. 
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Figure 68. Making Fields Required

Selecting the Incremental option sets up a field which increments the field descriptor by one 
for each measurement taken. This option is handy for measuring several items with identical 
descriptors, such as samples within a single lot, or several instances of the same part number, 
because it appends the incremental number to the descriptor.

For example: P/N 455A2-1, P/N 455A2-2, P/N 455A2-3.

Another Example: Impeller-1, Impeller-2, Impeller-3.

Figure 69. Making Fields Incremental
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Selecting Clear Every Reading will toggle between two states. By default, the field will fill with 
the data which was input during the last reading. By selecting Clear Every Reading, you tell 
the instrument to clear the data from the field for each new reading, insuring that the person 
taking the reading must input new data each time. This is very useful for times when the data 
descriptor is expected to vary widely between readings. 

Figure 70.  Clearing Data for New Readings

The state of each of these options can be seen in the Field Status Window at the bottom of the 
Construction Window. All options in effect for the field selected are checked.

Figure 71. Field Status Window - Default

This shows a field with no options in effect, the default configuration. This is a field that will 
present the previous reading’s data for this field - which may be changed by the user - without 
incrementing it, but does not require the user to input any data if there is none already there 
from a previous reading. 
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Figure 72. Field Status Window - Options Enabled

This shows a field with both Required and Clear Every Reading options in effect. This 
presents a field that is cleared for each reading, and must be filled in by the user before a 
reading is taken.

Selecting Edit from the pop-up menu allows you to edit the name of the field in the Editing 
Window to the right of the Construction Window.

Figure 73. Editing the Field Name

Selecting the box to the left of the field toggles the Required option on or off.
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Figure 74. Toggling the Required Option

Selecting Copy from the pop-up window allows you to copy the currently selected field.
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Figure 75. Copying the Current Field

Once you copy a field, the Paste option can be selected to paste the copied field into the 
Construction Window.

Figure 76. Pasting a Copied Field

Selecting the New Entry option from the pop-up menu allows you to define a choice for the 
user for this field. 
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Figure 77. Creating a New Entry

This is a New Entry in the Construction Window. 

Figure 78. New Entry in the Construction Window

The “E” is for “Entry.” You can edit the entry once it is created, the same way as you edit the 
field name. Right click on the entry name, and choose Edit from the pop-up menu.

Figure 79. Editing the New Entry

You can sort your entries by name, alphanumerically, by right clicking on the field and 
selecting “Sort” from the pop-up menu.
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Figure 80. Sorting Entries

To delete a field or entry, just right click on the item you wish to delete, and select Delete 
From the pop-up menu.

Figure 81. Deleting Fields and Entries

When you are finished creating your new NDF file, Upload it to your instrument using the 
Upload icon. 

Figure 82. Uploading the NDF File

Make sure the instrument is connected to your computer by testing the connection first. Use 
the Test button on the Upload Window.
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Figure 83. Testing the Upload Connection
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Safety Settings
Access to the Safety Settings Screen is blocked unless the user logging in has explicitly been 
granted Safety access. The default login of 1234 does not have Safety access. See Passwords 
and User Privileges.

Figure 84.    Safety Settings Menu Path

Using the proximity 
button helps protect 
against back scatter 
radiation.

The orange interlock 
button is located on the 
nose of the instrument, 
at the very bottom.

The interlock button 
requires 2 handed 
operation to take a 
reading.

See “Navigation” on 
page 6 for the 
interlock button 
location.
Thermo Scientific Niton XL2 Plus User’s Guide 105



6 Advanced Settings
Safety Settings
The Safety Settings Screen enables you to change the Method of Operation for your 
analyzer. Each checkbox on the screen enables or disables the safety device named for purposes 
of the preconditions for operation. For example, checking the Proximity Button Required 
checkbox sets the engagement of the Proximity Sensor as a precondition for operation. 
Checking the Proximity Button Required checkbox and the Interlock Button Required 
checkbox sets the engagement of both the Proximity Button and the Interlock Button as 
preconditions for operation.

Safety settings always override start-stop settings. If your safety setting requires the use of the 
Proximity Button, you cannot set start-stop settings which ignore the Proximity Button. For 
example, the Easy Trigger start-stop setting must have the Backscatter safety setting enabled. 
While using Easy Trigger, you cannot disable Backscatter.

WARNING  The backscatter sensor is enabled by default and acts as a recommended safety 
feature for most applications. Some sample types, however, cannot be analyzed when this 
feature is enabled. Samples that present very little mass to the analysis window, such as certain 
thin films, thin layers of plastic, and very thin wires, may not be of sufficient mass to allow the 
analysis to continue while backscatter is enabled. One should disable the backscatter feature 
only when necessary to analyze such low mass samples, and re-enable the feature when 
finished with these sample types. These samples also provide very little absorption of the 
primary x-ray beam so it is typically most appropriate to analyze these samples in a test stand 
when possible.
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Start/Stop Setup

Figure 85.    The Start/Stop Settings Menu Path

The Start/Stop Setting Screen enables you to change the preconditions for operation at a 
lower level than the Safety level. See Safety Settings for more information. Start/Stop settings 
cannot contradict Safety settings. 

The Start/Stop parameter options are Proximity Start and Remote Trigger. There is also a field 
to set the maximum time for sample analysis before the analysis stops.
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Proximity Start

Select the Proximity Start checkbox to use the Proximity Start parameters. Using Proximity 
Start, once the reading has been started, release of the Proximity Button will immediately stop 
the analysis. You cannot use Proximity Start with Easy Trigger.

Remote Trigger

Select the Remote Trigger checkbox to use the Remote Trigger parameters. Remote Trigger is 
used with the Extend-a-Pole accessory to control the analysis. With the Extend-a-Pole's input 
cable connected to the analyzer's Remote Trigger port, you can initiate and stop analysis 
remotely from the Extend-a-Pole's handle trigger. You can use Remote Trigger with either 
Proximity Start or with Easy Trigger.

Max Time Field

  

Figure 86.    The Max Test Time Editor

Select the Max Time field to change the maximum analysis time parameter. 
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CAUTION  After being powered on, your Niton Analyzer will perform an internal 
re-calibration before an analysis is initiated. 

There are six different methods of operation for taking a sample measurement, and your 
analyzer will be configured to use one of those methods for alloy samples, depending on the 
regulatory requirements of your locality. These methods are:

• Trigger-Only method. With the Trigger-Only method, you only need to place the 
measurement window flush with the sample to be analyzed and pull the trigger for sample 
analysis to be initiated.

• Trigger-and-Proximity-Sensor method. With the Trigger-and-Proximity-Sensor method, 
you must place the measurement window against the sample to be analyzed to engage the 
proximity sensor on the front of the analyzer, then pull the trigger for sample analysis to 
be initiated.

• Momentary-Trigger-Touch-and-Proximity-Sensor method. With the 
Momentary-Trigger-Touch-and-Proximity-Sensor method, you must place the 
measurement window against the surface to be analyzed to engage the proximity sensor 
on the front of the analyzer, then pull the trigger. The trigger may be released and the 
reading will continue until you release the proximity button, or other criteria (such as 
Max Time) are reached.

• Trigger-and-Interlock method. With the Trigger-and-Interlock method, you need to 
place the measurement window close to the sample to be analyzed, press and keep 
pressing the interlock button at the rear of the analyzer with your free hand, then pull the 
trigger for sample analysis to be initiated. The interlock button is located at the very 
center of the keypad, in between the left/right, up/down arrows.

• Trigger-Interlock-and-Proximity-Sensor method. With the 
Trigger-Interlock-and-Proximity-Sensor method, you must place the measurement 
window against the sample to be analyzed to engage the proximity sensor on the front of 
the analyzer, press and keep pressing the interlock button at the rear of the analyzer with 
your free hand, then pull the trigger for sample analysis to be initiated.

• Easy Trigger method. With the Easy trigger method, you need only place the 
measurement window against the sample area and pull the trigger once to initiate a 
sample analysis. Your analyzer will continuously sample the backscatter, using a complex 
internal algorithm, to determine if the measurement window is against a sample or 
pointing to the empty air. If it finds that there is no sample directly against the 
measurement window, the analyzer will stop directing radiation through the window as 
soon as this determination is made.

The analyzer is constantly checking the backscatter characteristics to determine if a sample is 
against the measurement window, whether or not the Easy Trigger method is being used, and 
will shut off any radiation directed through the window if it determines that there is no 
sample present.
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With any of these methods, analysis will stop if any one of the preconditions are violated. For 
example, with the Trigger-Interlock-and-Proximity-Sensor method, if the trigger or the 
Proximity Sensor or the Interlock is released, the reading will stop immediately, and the X-ray 
tube will shut down.

After your analyzer is calibrated, initiate a sample reading using the appropriate method. If 
you attempt to initiate a sample reading using a different method, the analyzer will inform 
you that one or more of the preconditions need to be met in order for sample analysis to 
begin.

Note  The LED lights will blink whenever the x-ray tube is on.

WARNING  The nose should not be touched during sample testing and calibration. If an ESD 
event occurs during measurement, the instrument may terminate the testing in progress and 
automatically reset to LogOn screen. Any test data collected prior to reset will be lost and the 
testing may have to be repeated.

 
WARNING  The preconditions for operation must be continued for the duration of the 
reading. If the preconditions are violated, the x-ray tube will turn off, the calibration shutter 
will close, and the measurement will end. The LED lights will stop blinking when the 
measurement is ended. The flashing of the LED lights is not synchronized to minimize 
power consumption.

To end the test, simply release the trigger mechanism, or any other applicable preconditions.
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The Camera feature is only usable with properly configured analyzers. 

If your analyzer is equipped with an internal video camera, you can turn that camera on and 
off, and turn the saving of images with the readings on and off through an interface. When 
the camera is on, the image will show in the Ready to Test screen. If the camera is off, saving 
of images will also be off. If the camera is on and the image saving function is also on, the 
images will automatically be saved with the reading. Saving images will curtail the maximum 
number of readings stored.

How to Use the Camera 

When a Camera equipped analyzer is in the Ready to Test screen, the video feed appears live 
on the analyzer’s touch screen. This is the image that can be saved with the sample analysis. 
When you take a measurement, if you choose to do so, the bitmap image will be saved on the 
analyzer along with the analysis results. The interface is accessible through the System menu.
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Figure 87. The Camera Menu Path
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Figure 88. Setting Up the Camera View and Image Saving

Selecting the empty checkbox next to Enable Camera will turn the internal camera on, 
displaying the camera view in the Ready to Test screen. Selecting the checkbox again turns the 
camera off. Enable Camera is enabled by default.

Selecting the empty checkbox next to Save Image will enable image saving with the analysis. 
Selecting the checkbox again will disable automatic saving of image data. Save Image is 
enabled by default.

Stored camera images from previous measurements can be viewed on the analyzer.
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Data Management

Viewing Data

Figure 89. The View Data Menu Path

Use the Data Screen to view previously taken test result readings. When the View Data icon is 
selected, the Results screen of your most recent test is shown on the Touch Screen.

Contents

• “Viewing Data” on page 115

• “Viewing Fingerprints” on page 122

• “Erasing Data, Readings, or Fingerprints” on page 123

• “Managing Libraries” on page 125
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Figure 90. The View Data Screen

Using the buttons on the control panel, you may view different readings or additional data for 
individual readings. Your analyzer will display the standard screen analysis. Pressing the Down 
Button on the 4-way touch pad will display a complete scrolling elemental chemistry listing. 
Each press of the Down Button scrolls the screen down to the next element. You can also use 
the scroll bar along the right side to scroll or page through the elements.

Scrolling Down Through the Complete Listing of Elements

Pressing the Left Button on the 4-way touch pad of your analyzer will display the previous 
reading, or if the first reading is currently displayed, the last reading. Pressing the Right 
Button on the 4-way touch pad will display the next reading, or if the last reading is currently 
displayed, the first reading in memory. Your analyzer can store up to 10,000 readings. You can 
also look at the complete x-ray spectra for each reading stored in the analyzer's memory.

Sorting Elements 

You can sort element rows by various criteria in order to view your data in the manner you 
prefer. The Sort Buttons, which double as column headings, can be used to re-sort the data in 
different ways. The default data screen displays the standard sort, as defined on “Advanced 
Settings / Element Sorting”. Selecting the appropriate Sort Button once toggles the sort order 
to High-to-Low. Selecting the Sort Button again toggles the sort order to Low-to-High. To 
return to the Standard Sort, select the Sort Button a third time.
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Figure 91. Standard, High-to-Low, and Low-to-High Composition Sorts

Element Sorts

Element sorts are performed alphabetically based on the element symbol.

Composition Sorts

Composition sorts are performed numerically based on the percentage of composition, i.e. 
from lowest to highest concentration, or by toggling again, from highest to lowest.

Error Sorts

Error sorts are performed based on the size of the error in the reading, i.e. from largest to 
smallest error, or by toggling again, from smallest to largest.
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Figure 92. Element, Composition, and Error Sorts

Spectrum Graph

For any reading result, simply use the NAV Menu to gain access to the reading’s spectrum 
graph. Selecting Spectra will show a graphed spectrum of this reading, called SpectraView. 
SpectraView can be a useful tool for rapid, qualitative analysis of a sample. See Viewing the 
Spectrum for details.

Figure 93. The SpectraView Screen
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Viewing the Spectrum

SpectraView

SpectraView enables you to visually inspect the fluorescent x-ray peaks obtained from any 
sample and qualitatively identify them using the on-board software. In SpectraView Mode, 
the spectrum is displayed using a linear energy scale along the x-axis, with the count rate 
autoscaled logarithmically on the y-axis so that the highest peak on the screen reaches the top 
of the scale.

How to Use SpectraView 

You can access the SpectraView screen after taking a measurement in any mode, or while 
viewing a previous measurement, by selecting Spectra from the NAV Menu. Once you are in 
SpectraView, you can use the up and down positions of the 4-way touch pad to scroll through 
the spectrum, or you can tap on the spectrum display with the stylus to place the cursor at the 
point you tapped. The vertical cursor line indicates the current position along the spectrum.

Viewing the Information in SpectraView Mode

Figure 94. The SpectraView Screen

By default, the following information is shown along with the spectrum:

• The Reading number (Bottom Left) in the form “Read:x”, where x is the Reading 
number.

• The position of the cursor on the energy scale (Bottom Left, under the Reading 
number), in the form “E: x.xx KeV”, where KeV is kilo electron volts.

• The count rate (Bottom Left, under the energy position), in the form “R:x.xx”.
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• Ka, Kb, La, Lb, and/or Lg peaks of the three elements closest to where your cursor is 
positioned on the energy scale (Bottom Right). This information is written with the 
element symbol first, followed by either Ka (K shell alpha peak), Kb (K shell beta 
peak), La (L shell alpha peak), La (L shell beta peak), or Lg (L shell gamma peak). An 
example would be “Al Ka 1.48." To determine if a given element is present, look at 
the count rate at that cursor position.

Note  SpectraView cannot be used to determine exact element percentages in a sample.

Fitting the Spectrum 

By using the touch screen, you can select parts of the displayed spectrum and zoom in. Touch 
and hold the stylus to the screen immediately before the area of the spectrum you wish to 
enhance, then - still holding the stylus to the screen - sweep it across the area of the spectrum 
you wish to see closer, lifting the stylus from the screen when you pass the end of the area of 
interest. The screen will display vertical lines to either side of the area of interest, delineating 
the boundaries of the area.

Figure 95. Delineating the Area of Interest

Select the FIT button in the upper right hand corner of the Spectrum to fit the area of interest 
to the display area.
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Figure 96. Area of Interest Fit to the Display

The view of the spectrum will change to show only the area of interest.

Multiple Ranges 

SpectraView can display any individual spectra, including those obtained from multiple 
Ranges (filters) if you are using more than one Range. Use the NAV Menu to select which 
spectrum to view.

The Spectra1 choice will display the spectrum produced by the first Range.

The Spectra2 choice will display the spectrum produced by the second Range.

SpectraView Navigation 

Use the left button on the 4-way touch pad to expand the spectrum, centered on the position 
of the cursor. 

Use the right button on the 4-way touch pad to contract the spectrum, centered on the 
position of the cursor.
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Viewing Fingerprints

Figure 97. The View Fingerprints Menu Path

Select the View Fingerprints icon to view data saved as reference sample Fingerprints in Teach 
Fingerprint Mode. When the View Fingerprints icon is selected, the Results Screen of your 
most recent Teach Fingerprint is shown on the Touch Screen display.

Figure 98. The View Fingerprints Screen
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Erasing Data, Readings, or Fingerprints
The Erase screens are shown below.

Figure 99. The Erase All Data Menu Path
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Erase All Data

Select the Erase All Data icon to erase all data, including signatures and readings, from your 
analyzer. Selecting the Erase All Data icon will bring up a confirmation screen asking you “Are 
you sure?” with options to select “YES” or “NO”. Selecting the Yes Button will erase all data 
from your analyzer. Selecting the No Button will return you to the Erase Menu.

Erase Readings

Select the Erase Readings icon to erase all accumulated test readings from your analyzer. 
Selecting the Erase Readings icon will bring up a confirmation screen asking you “Are you 
sure?” with options to select “YES” or “NO”. Selecting the Yes Button will erase all test 
reading data from your analyzer. Selecting the No Button will return you to the Erase Menu.

Erase Fingerprints

Select the Erase Fingerprints icon to erase all accumulated alloy fingerprints from your 
analyzer. Selecting the Erase Fingerprints icon will bring up a confirmation screen asking you 
“Are you sure?” with options to select “YES” or “NO”. Selecting the Yes Button will erase all 
fingerprint data from your analyzer. Selecting the No Button will return you to the Erase 
Menu.
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Managing Libraries

Figure 100. The Manage Libraries Menu Path

Select the Manage Libraries icon to access the Library Management Menu. The Library 
Management Menu allows you to view and modify data in the Primary Library as well as the 
currently loaded alternate libraries. Just select the library you wish to view or edit from the list 
on screen.
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Figure 101. Viewing the Libraries

The entries in the Grade Library serve as a reference for chemistry based analysis. The library 
entries allow the analyzer to work properly “out of the box” without needing time-consuming 
pre-analysis.

Figure 102. The Library Editor
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Using the Library Editor 

The Library Editor enables you to edit any library to conform to your specifications.

Alloy Name Button 

Selecting the Alloy Name Button sorts the alloy list alphanumerically.

(Name in List) 

Selecting the actual name of the alloy - i.e. “Fe/CS” - will bring up the Element Specification 
Screen.

Add Button

Selecting the Add Button will add a new alloy to the Library. First the Alloy Name Editor will 
appear, enabling you to enter the name of the new alloy.

Figure 103. The Alloy Name Editor

The Alloy Name Editor is a standard Virtual Keyboard. Use it as you would any Virtual 
Keyboard. Hitting the return key enters the name into the alloy list. Select the name of the 
new alloy to bring up the Element Specification Screen and enter the specification of the alloy.

Del Button

Selecting the Del Button will delete the currently selected alloy. First a confirmation screen 
appears.
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Figure 104. Confirmation Screen

Selecting the Yes Button will delete the alloy from the list. Selecting the No Button will return 
you to the Alloy List.

The Element Specification Screen

The Element Specification Screen allows you to edit the elemental content of any alloy.

Figure 105. The Element Specification Screen

Library name

Alloy name

Element to be 
edited

Minimum or 
Maximum 
percentages
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Library Name 

This is the name of the library you are editing. Make sure you are editing the correct library 
before proceeding further.

Alloy Name 

This is the name of the alloy you are editing. Make sure you are editing the correct alloy 
before proceeding further.

Element to be Edited 

This is the element you need to edit for this alloy.

Minimum Percentage 

This is the lowest amount of the element in question you want to be in the alloy. If the 
element in the analyzed sample is any lower, the sample will not be recognized as this alloy. 
Selecting the element minimum will open the Minimum Editor.

Maximum Percentage 

This is the highest amount of the element in question you want to be in the alloy. If the 
element in the analyzed sample is any higher, the sample will not be recognized as this alloy. 
Selecting the element maximum will open the Maximum Editor.
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8

Connectivity

This section discusses how to connect your computer and your analyzer, for data transfer and 
integration, translation to other formats, data storage and security, as well as controlling your 
analyzer remotely through your computer. Connection can be achieved via USB. 

Installing the Windows 7 USB Driver
NOTE: Other versions of the Windows Operating System do not require the USB driver.

1. Insert the NDT CD and close out any dialogue box that pops up. The driver is located on 
this disk. 

Contents

• “Installing the Windows 7 USB Driver” on page 131

• “Using a USB Cable to Connect Your Analyzer” on page 136

• “Downloading Data” on page 136
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2. Click on “Control Panel” and locate the “Device Manager”. If it is not available directly 
under “Control Panel”, look under “System and Security” then “System”. 
132 Niton XL2 Plus User’s Guide Thermo Scientific



 8 Connectivity
Installing the Windows 7 USB Driver
3. Open “Device Manager” 

4. Plug in instrument using the USB cable provided 

5. Message will appear “Device Driver Software Not Successfully Installed” 

6. In “Device Manager”, “Unknown Device” will appear under “Other Devices” 

7. Right click on “Unknown Devices”; select “Update Driver Software” 
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8. Click on “Browse My Computer for Driver Software” 
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9. Click “Browse” button; select CD drive or the location of the driver if you are not 
installing from the NDT CD (recommended). 

10. Click “OK” 

11. Click “Next” 
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12. A Security Dialog Box will appear. Select “Install This Driver Software Anyway?”

13. Driver will install; close out. 

Using a USB Cable to Connect Your Analyzer

To connect the XL2 Plus Analyzer to your PC using the USB cable:

1. Insert the Standard USB connector on the USB cable into a USB port on your computer.

2. Open the Port Cover on the XRF Analyzer.

3. Turn on the analyzer and insert the mini USB connector on the USB cable into the USB 
port in the handle of the XRF Analyzer.

Downloading Data

Standard Download

To download data you have collected off line:

1. Make sure that the XRF Analyzer is connected to your computer. 

2. Turn on the XRF Analyzer. 
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Note  Wait at least 30 seconds after turning on the XRF Analyzer to begin downloading files. 
The System Start screens do not allow downloading.

3. Start Niton Data Transfer.

NOTE: Niton Data Transfer and NDTr cannot both be open at the same time.

4. Click the Download button. The Download dialog box will open.

Figure 106. The Download Button

5. In the Download dialog box, Select the Test button to test the serial connection to the 
Analyzer.

Figure 107. The Test Button

6. You should get a pop-up window informing you that the connection tested successfully. If 
the test fails, there is a problem with your serial port setup. Click Settings and select 
another communication port.
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Figure 108. Communication Port Window

7. In the Download dialog box, click the Connect button.

Figure 109. The Connect Button

8. Click the Query Readings button. This will return a list of all current readings on your 
analyzer. The list appears in the large white box in the Download dialog box.
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Figure 110. Current Reading List

9. Select the readings that you want to download. There are two ways to do this.

a. Click the boxes next to each of the reading numbers to select or de-select individual 
readings. You can select a range of readings by pressing the shift key, then selecting 
the first and last reading in the range. All readings from the first reading selected to 
the last will then be selected.

Figure 111. Selecting Readings

b. Click the boxes on the left to select or de-select all the readings of a specific type. You 
can also use the Shift-Click method of selecting a range of readings as described 
above.
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Figure 112. Using Check Boxes

10. The download generates a data file containing the selected readings. To save the file for 
later use:

c. Enter the path for the file in the Destination Folder field. You can use the ... button 
to browse.

Figure 113. The Browse Button

d. Enter a name for the file in the File Name field.
CAUTION  Some characters are not allowed in the file name. Characters such as the “#” sign 
will cause an error. Niton recommends using only alphanumeric characters “-”, “_” and the 
space character when naming a file.

e. Click the Download button.
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Figure 114. The Download Button

When the progress bar shows that all the readings are downloaded, click the Done button.

Figure 115. The Progress Bar
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You should now see the readings you selected for download displayed, one reading per 
horizontal line. The data has been saved to the folder and filename you indicated prior to 
downloading. If an error message has appeared, see the following section.

You can also automatically save reports in .csv format for importing into Excel or other 
programs.Simultaneous Save as CSV File

Table 8: Error Messages while Downloading

Error Message Action

Couldn't open \\.\COM7 Error 
Code: 2

Select another COM port.

The port \\.\COM2 is in use Select another COM port.

Please Open the Port Click the Connect button.

Hardware Not Responding
or
Hardware Not Ready

Turn on the XRF Analyzer.
If you are using a serial cable, check that the cable is 
inserted snugly.
If you are using a serial cable, select the other COM 
port.
If you are using the wireless USB adapter, connect the 
serial port. See the “Installing and Using Bluetooth” 
manual for complete instructions on setting up the 
Bluetooth adapter to work with your analyzer.
Check that the spare battery is fully charged.

The Serial Port connection failed: 
RFCOMM connection failed

Check that the battery is fully charged.

WARNING: 38400 baud rate not 
supported.

This indicates a potential problem. Test the serial port. 
If there is a problem connecting, switch baud rate on 
both the analyzer and the NDT software to 115200.

Incorrect Data in reading # XXX.
Reading will be skipped.
Error code: BOUNDARY_ER-
ROR1.

This indicates a version mismatch between your 
instrument code and the NDT code running on your 
computer. Use a version of NDT that matches the ver-
sion number of the software on your analyzer.

Incorrect Data in reading # XXX.
Reading will be skipped.
Error code: BOUNDARY_ER-
ROR2.

This indicates a version mismatch between your 
instrument code and the NDT code running on your 
computer. Use a version of NDT that matches the ver-
sion number of the software on your analyzer.

Incorrect Data in reading # XXX.
Reading will be skipped.
Error code: BOUNDARY_ER-
ROR3.

This indicates a version mismatch between your 
instrument code and the NDT code running on your 
computer. Use a version of NDT that matches the ver-
sion number of the software on your analyzer.
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Note  When using the wireless USB adapter, if the serial port repeatedly disconnects, check 
that the battery is fully charged.

Live Download (Automatic Save)

If desired, your Niton XL2 Plus analyzer has the capability to download and store each 
reading to the PC in real time to a file of your choice. To enable this feature, you must do the 
following:

• Your Niton analyzer must be turned on and connected to the PC. See Using a USB Cable to 
Connect Your Analyzer.

• The NDTr program module must be running and connected to your analyzer. See 
Operating Your Analyzer Remotely.

• The Download icon in the NDTr toolbar must be selected.

Figure 116. Live Download Icon

The file created is in a format readable by the NDT program module, has an extension of 
.ndt, and looks identical to a file of manually downloaded readings - see Standard Download. 
It can also create a simultaneous .CSV file. Simultaneous Save as CSV File .

Please note the following:

1. When the instrument is unplugged, selecting the Download icon does nothing.

2. When you disconnect, then reconnect, your analyzer, Download appends future readings 
to same file.

WARNING: 115200 baud rate not 
supported.

This indicates a potential problem. Test the serial port. 
If there is a problem connecting, switch baud rate on 
both the analyzer and the NDT software to 38400.

SH4 Successfully Communicating 
Result: SUCCESS

This indicates a normal connection.

Table 8: Error Messages while Downloading
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3. Live Download does not overwrite any previous readings in the file. If you want to do 
this, you must first explicitly erase the file before initiating Live Download.

4. Live Download does not retroactively add any readings taken while your analyzer was 
disconnected.

Changing the Filename for Live Download

Once you have selected the Download icon, a dialog box appears as shown below:

Figure 117. File Dialog Box

You can change the destination file or folder by clicking in the appropriate text box and typing 
in the new file name, or by clicking on the browse button (...) to the right of the text box and 
selecting a different pre-existing filename. To implement these changes, click the OK button.

Your instrument serial number is associated with the file. If a different instrument is 
connected and Live Download is started, a message will appear saying that the connected 
instrument and file instrument do not match, and Live Download will not start. Saving the 
session as a new file will alleviate this issue

Simultaneous Save as CSV File

By clicking on the checkbox box labeled “Save the readings to CSV file as well” you can 
enable simultaneously saving the data as a standard CSV (Comma Separated Value) file for 
use with other programs.
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9

Controlling Your Analyzer From Your PC

The NDTr program allows you to completely control your Niton analyzer remotely, from 
your computer. It works over serial or USB connection over the supplied connector, or 
Bluetooth wireless communication. See Using a USB Cable to Connect Your Analyzer for 
details on how to connect your Analyzer and PC.

The NDTr Toolbar 

The NDTr Toolbar is a string of icons along the top of the NDTr window. It looks like this:

NOTE: NDTr and Niton Data Transfer cannot both be open at the same time.

Figure 118. The NDTr Toolbar

Start Measurement 

Clicking this icon will initiate a measurement in whatever mode the analyzer is in currently.

Stop Measurement 

Clicking this icon will halt any ongoing measurement on the analyzer.
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Configure Connection Settings

Clicking this icon will allow you to change your configuration settings.

Connect 

Clicking this icon will attempt to establish a connection between your computer and your 
analyzer.

Disconnect 

Clicking this icon will disconnect your computer from your analyzer.

Live Download

See Live Download from NDTr

Configure Connection Settings

Clicking on the Configure Connection Settings icon allows you to change the Com Port for 
connecting your computer to your analyzer. Once you click on the icon, a settings dialog box 
will appear.

Figure 119. Connection Settings Dialog Box

Selecting the Com Port

Selecting the down arrow in the “Connect Using” field will display the various Com Ports on 
the computer that the analyzer can connect through. 
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Figure 120. Selecting the Com Port

Select the proper com port from the list, then select the OK Button.

Operating Your Analyzer Remotely

NDTr version 7 and above virtual interface operates exactly as the analyzer would. Selecting 
the buttons, icons and menus with your mouse works exactly as if you were selecting them 
with your finger or stylus on the real analyzer.
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Figure 121. Niton XL2 Plus Virtual Interface 

Live Download from NDTr

Once you have connected to your analyzer using NDTr, click on the Download icon on the 
NDTr toolbar. When you click the Download icon, a Download dialog box will appear.
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Figure 122. File Dialog Box

Dest Folder 

This field shows the last used save folder, defaulting to the folder where NDT is installed.

... (Browse Folders) Button 

Selecting this button enables you to select a different folder for saving the file. This will 
change the Dest Folder Field.

Selected File 

This shows the filename the reading will be saved to unless you change it. 

... (Browse Files) Button 

Selecting this button enables you to select a different file name by browsing the file listing. 
The file extension “.ndt” will be appended to the name - i.e. File name “file” will be saved as 
“file.ndt” and the file will be in the NDT format.

Save the Reading to CSV File as Well Checkbox

Selecting this checkbox enables you to create a second autosave file with CSV format for 
importing into spreadsheets such as Excel. This file will have the same name as the NDT file 
above, but with the file extension “.csv” instead - i.e. “test.ndt” will be saved as “test.csv” as 
well. The checkbox is selected when there is a check in it, and deselected when it is empty.

Always Show this Dialog Box when the File button is Pressed Checkbox 

Selecting this checkbox will enable you to change the filename whenever you want. 
Deselecting this checkbox will save the file under the same name in the same folder every 
time. The checkbox is selected when there is a check in it, and deselected when it is empty.
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10
Instrument Maintenance and Support

This section of the User guide is about getting the most out of your analyzer. We cover 
troubleshooting your analyzer by using the Specs screen. We also cover advanced topics like 
setting thresholds, using the Tools menu, correcting for light elements in the sample 
composition, setting up pass/fail analysis, changing safety and start/stop parameters, and 
many other special situations you may need. We have also included a number of documents 
for reference, so you can learn more about XRF analysis if you are so inclined. 

Replacing the Measurement Window
WARNING  Before you begin, remove the battery from your analyzer!

• Remove the two screws holding the Measurement Window Bracket to the nose of your analyzer. 

Figure 123. Removing the Window Bracket Screws

• Remove the Measurement Window Bracket from the analyzer, and turn it over, exposing the 
back with seal and Measurement Window.

Contents

• “Replacing the Measurement Window” on page 153

• “Tips and Troubleshooting” on page 156

• “Storing and Transporting Your Niton XL2 Plus Analyzer” on page 162
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Replacing the Measurement Window
• Remove the old Measurement Window from the bracket.

Figure 124. Removing the Old Window 

• Clean the Window bracket area thoroughly, using a clean, guaranteed lint-free cloth and 
isopropyl alcohol.

• Measurement Window for XL2 Plus is clear Prolene (P/N 447-33771).

.

Figure 125. Prolene Window P/N 447-33771

.

Pick one
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• When the bracket is clean, remove the backing from the Measurement Window. Place the 
window on the Bracket gently. Make sure the opaque portions of the window do not intrude 
over the large measurement hole in the Bracket.

Figure 126. Removing the Backing from Prolene Window (Left) and Applying Window to Bracket (Right)

CAUTION  Do not use fingers to press window into place! Use a smooth, hard surface such as back of 
tweezers.

Figure 127. Measurement Window Replaced

• Replace Window Bracket on the front of your analyzer, then insert screws.
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Tips and Troubleshooting

The Specs Screen

Figure 128.    The Specs Screen Menu Path

Select the Specs icon from the System Menu to display the analyzer's specifications. These 
specifications include your analyzer's serial number, software and firmware versions, and other 
data. Press the Close Screen Button to return to the previous menu. Press the “>-” Screen 
Button to go to the Diagnostic Menu, and press the “<-” Screen Button to return to the 
Specifications Screen.
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Figure 129.     The Specifications Screen

On the Specs Screen, standard information on the state of your analyzer is shown for your 
reference. This information should be reported to Service if there is a problem.

Specs Information

The following is the information supplied on the Specs Screen:

Instrument Specific Serial Number

This is located in the left part of the blue band at the top of the screen.

Model Number

This is located in the right part of the blue band at the top of the screen.

Date And Time

This is the current Date and Time. This is particularly important for date stamping.

SW Version

This is the currently loaded software version, which should be reported to Service if there is 
any problem.
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FPGA

This is the currently loaded FPGA software version, which should be reported to Service if 
there is any problem. FPGA versions are always a four digit number. Any other number of 
digits may be a sign of a problem in the FPGA code.

Factory QC

This is the date that the machine was QCed at the factory.

Energy Cal

This line notes the last time a System Check was performed.

Battery

This line gives the proportional charge remaining to the battery.

System Check Reminder

Select the OFF Screen Button after “System Check Reminder” to set a reminder to calibrate 
your analyzer. Selecting the button will open the Cal. Reminder Editor. Select the number of 
days you want between reminders with the numeric keys. Of the other screen buttons, C = 
Clear All, E = Enter, and OFF shuts off the Reminder Function. Selecting the E button will 
enter the current value as the reminder interval and return to the Specs Screen.

Figure 130.    Cal Reminder Editor Screen
158 Niton XL2 Plus User’s Guide Thermo Scientific



 10 Instrument Maintenance and Support
Tips and Troubleshooting
Diagnostics

Select the “->” Screen Button to load the Diagnostics Screen. The Diagnostics Screen shows 
Detector Temperature, Bias, Cooler Voltage, SubBias, Energy Scale, and Temperature in C 
and F scales.

The Diagnostics Screen can be of great utility in assuring proper operation of your analyzer.

Figure 131.    The Diagnostics Screen

The proper ranges of operational values on the Diagnostics Screen follow.

Det Temp:

Detector Temperature should be within this range:

- 25 + or - 5 degrees

Bias:

Bias should be within this range:

175 + or - 10

VCool:

VCool will vary with the ambient temperature.
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SubBias:

SubBias should be within this range:

-11 + or - 3

Escale:

Escale should be within this range:

6.6 through 9.0

Preamp:

Preamp value should only be noted, and reported to Service if there is a problem.

Registration and Licensing FAQ

As a user of a Niton XL2 Plus analyzer, you may be required to register or obtain a license 
with your local radiation control authority. In the US, if you intend to do work with your 
analyzer in states other than your own, you may be required to register there as well. Below is 
a list of commonly asked questions that come up when filling out registration forms.

FAQ 

Q: What is the max mA, max kVp, and max power?

A: Maximum mA is 200 uA

   Maximum kVp is 45 kVp

   Maximum power: 2 watts

 

Q: What is the accelerator voltage or MeV?

A: This should be filled out as not applicable N/A as it does not apply to Niton XL2 Plus 
analyzers.

 

Q: What is the radioisotope?

A: There are no radioactive isotopes in Niton XL2 Plus analyzers.
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Q: What category is the Niton XL2 Plus?

A: States differ greatly in their categories; the following is a list of common categories:

• X-Ray Fluorescence

• Analytical or Analytical XRF

• Open Beam or Open Beam Analytical

• Portable Gauge or Portable XRF

• Industrial Analytical or Non-Destructive Testing

When selecting the category make sure that you don't select medical or radiographic.

 

Q: How many tubes are in the Niton XL2 Plus?

A: One.

 

Q: What is the analyzer serial number?

A: The serial number of the tube can be found on the Calibration Certificate that is included 
in the shipping case with your analyzer. 

 

Q: What is the tube serial number?

A: The serial number of the tube can be found on the Calibration Certificate.

 

Q: What is the type of X-Ray Processing?

A: None. Niton XL2 Plus analyzers do not use film.

 

Q: How often do I need to perform leak tests on the Niton XL2 Plus?

A: Never. Leak tests are only required for analyzers with radioactive isotopes. Niton XL2 Plus 
analyzers do not have radioactive isotopes.
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Storing and Transporting Your Niton XL2 Plus Analyzer
All Niton Analyzers are transported in waterproof, drop-resistant, fully padded carrying cases 
with padlocks. In most countries, Niton XRF analyzers may be transported by car or plane or 
shipped as an ordinary package. For most courier services, no special labels are required on the 
outside of the Niton analyzer case or on additional packaging.

Figure 132. The Niton Carrying Case

All padlocks are shipped with a default combination of “0-0-0”. If you change this 
combination, please inform Thermo of the new combination if you return the unit for 
service.

To change the combination: 

1. Dial the default combination to open the lock, and pull out the shackle. 

2. Rotate the shackle 180 degrees and push it down as far as it can go. 

3. While holding the shackle down, rotate it 90 degrees back in either direction and release 
shackle. 

4. Change the dial settings to the desired combination, record the combination, and 
without disturbing the dials, rotate the shackle back 90 degrees to the position it had in 
step 2.
162 Niton XL2 Plus User’s Guide Thermo Scientific



 10 Instrument Maintenance and Support
Storing and Transporting Your Niton XL2 Plus Analyzer
5. Pull shackle out and rotate it 180 degrees and secure it. Your lock now has its own secret 
combination.

CAUTION  Always transport the unit in its padded carrying case, and store the Niton Analyzer 
in its case whenever it is not being used.

CAUTION  In most cases, no notification is required if transporting within state boundaries. 
This may not be the case when entering federal properties.

CAUTION  Within the United States, always keep a copy of the US DOT compliance 
statement in your Niton analyzer case at all times. A copy is included with your analyzer.

CAUTION  Always follow all pertinent local and national regulations and guidelines, wherever 
your analyzer is transported or used.

CAUTION  Always obtain a Return Authorization (RA) number from Thermo Fisher 
Scientific’s Service Department in the United States, toll free, at (800) 875-1578, or outside 
the United States, at +1-978-670-7460 before returning your analyzer to the Service 
Department or to your local Authorized Niton Analyzers Service Center.

CAUTION  If you return your Niton analyzer without the carrying case, you will void your 
warranty in its entirety. You will be billed for a replacement case plus any repairs resulting 
from improper shipping.

CAUTION  Always remove the battery pack when transporting or storing your analyzer.
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Storing and Transporting Your Niton XL2 Plus Analyzer
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11
Test Stands

The Portable Test Stand
Shielded test stands are useful accessories to use to analyze the following types of samples:

• light materials (such as plastic, wood, or similarly low density/low atomic mass samples)

• thin samples (such as foils, circuit boards, and wires)

• samples that are smaller than the analysis window.

See “Safe Handling of Samples” on page 14 for more details.

Contents

• “The Portable Test Stand” on page 165

• “The Mobile Test Stand” on page 173

• “Configuring the Analyzer for the Test Stand” on page 175

• “The Field Mate Test Stand” on page 181

• “Configuring the Analyzer for the Test Stand” on page 189
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11 Test Stands
The Portable Test Stand
Figure 133. The Portable Test Stand: PN 420-017

User Accessible Connectors on Test Stand

Setting Up the Portable Test Stand

1. To set up the Portable Test Stand, place the folded stand on your bench top with the 
scissored legs down. 
CAUTION  When setting up and taking down the Portable Test Stand, be aware of possible 
pinch points.

2. Lift up the top part of the Portable Test Stand. As you do so, the scissored legs will rise up 
and come together.

3. Hook the notch in the back, flat part of the top over the bar between the rear legs, as in 
Figure 134.

Test Stand power 
specification: 
12vDC, 1A

See test stand 
“Power Supply PN 
420-011” on 
page 24.

Connector Voltage Level Manufacturer and Part Number

DC Power JACK 12V CUI, 
PJ-014CH-SMT

Remote Trigger 3.3V CUI, 
SJ-3523-SMT

USB port 5V Molex, 
56579-0576
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 11 Test Stands
The Portable Test Stand
Figure 134. Hooking Over the Bar

4. The Portable Test Stand is now ready for use.

Figure 135 shows a Portable Test Stand ready for use.

Figure 135. The Test Stand All Set Up
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11 Test Stands
The Portable Test Stand
Taking down the Portable Test Stand

1. First, unhook all cables from the instrument and/or test stand.

2. To take down the Portable Test Stand, unhook the back, flat part of the top section of the 
Test Stand. The hood locks shut with a sliding tab for transportation.
CAUTION  When setting up and taking down the Portable Test Stand, be aware of possible 
pinch points.

3. The air pistons between the scissors legs will let the top down slowly.

4. Support the top until the legs have fully collapsed. Figure 136 shows a Portable Test Stand 
fully collapsed.

Figure 136. The Portable Test Stand Collapsed

Connecting the Portable Test Stand to your Analyzer

Use the included Remote Trigger Cable to attach the Portable Test Stand to your Analyzer. By 
connecting the Test Stand, your analyzer knows whether the protective lid is open or closed, 
and thus whether it is safe to initiate a test, as in Figure 141. If unplugged, the instrument will 
not be able to initiate a reading.
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 11 Test Stands
The Portable Test Stand
Figure 137. Plugging the Remote Trigger Cable Into the Portable Test Stand

Attaching the Remote Trigger Cable

Insert one end of the Cable into the Remote Trigger Port on your Portable Test Stand, and the 
other end to the Remote Trigger Port on your Analyzer, as in Figure 137 and Figure 138. Do 
not plug the cable into the Serial Ports.

Figure 138. Plugging the Remote Trigger Cable Into the Analyzer
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The Portable Test Stand
Powering the Test Stand via USB

Plug the USB cable into your computer’s open USB port as in Figure 139. Plug the other end 
into the Test Stand’s USB Port. The Test Stand can draw what power it needs from your 
computer.

Figure 139. Plugging the USB Cable into the Portable Test Stand

Powering the Test Stand Via Separate Power Cable

You may also use the power adaptor to power up the test stand. Plug the power adapter into 
the power port on your Portable Test Stand, and the other end into the wall outlet.
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 11 Test Stands
The Portable Test Stand
Figure 140. Plugging the Power Cable into the Portable Test Stand

Figure 141. Test Stand Open and Closed Icons

How to Use the Portable Test Stand

When the Portable Test Stand is fully set up, insert the front of your analyzer into the cone 
under the floor of the top part of the stand, as in Figure 142. Push firmly until the analyzer 
seats with an audible click.

Open        Closed
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11 Test Stands
The Portable Test Stand
Figure 142. Portable Test Stand with Analyzer Attached

Your analyzer cannot be inserted fully in any orientation but the correct orientation, with the 
touch screen towards the front.

To remove your analyzer, simply squeeze the tabs on either side of the cone and pull the 
analyzer down, gently but firmly, until it separates from the cone.

When the hood is lifted, your analyzer will display a red icon at the top of the touch screen, as 
in Figure 143.

Figure 143. Portable Test Stand Open Icon

Your analyzer will not take a reading unless the hood is shut and the green icon is on.
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 11 Test Stands
The Mobile Test Stand
The Mobile Test Stand

How to Assemble the Mobile Test Stand (PN 430-032)

Attaching the legs to the main body

1. Orient the pop-up peg on the leg with the hole in the main body

2. Push the pop-up peg in with your thumb as shown in Figure 144.

Figure 144. Pushing in Peg

3. Slide the leg into the main body until the pop-up peg snaps into the matching hole as 
shown in Figure 145.
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11 Test Stands
The Mobile Test Stand
Figure 145. Attaching Leg

4. Repeat for each leg

5. Adjust the height of each leg by screwing or unscrewing the feet to allow a level platform

Fitting your Niton analyzer into the Mobile Test Stand

6. Set the test stand so that the hinge is away from you, and you have access to the test 
chamber when it is open.

7. Place your analyzer underneath the Mobile Test Stand so that the nose points up and the 
touch screen is facing you, as in Figure 146.
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 11 Test Stands
Configuring the Analyzer for the Test Stand
Figure 146. Inserting Analyzer into Portable Test Stand

8. Lift your analyzer firmly up into the recess until the clips snap solidly into place on both 
sides of the analyzer’s front end.

Configuring the Analyzer for the Test Stand
The test stand contains an RFID chip, which automatically configures your analyzer to 
properly work with the test stand. 
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Configuring the Analyzer for the Test Stand
Proximity Start Feature

A feature you can optionally use is to set the analyzer to Proximity Start. 

Figure 147. Menu Path to Set Proximity Start 

Press the trigger to initiate the reading, and disengage the Proximity Button by opening the 
cover to stop the reading. With this feature enabled, you do not need to hold the trigger down 
while the sample is being analyzed.
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 11 Test Stands
Configuring the Analyzer for the Test Stand
Figure 148. Stopping the Analysis by Opening the Cover

You can always use standard operation, as well as remote operation via NDTr.

Measuring Small Parts and Components

To measure electronic parts and components, place the part to be measured directly on the 
measurement window of the analyzer, shut the hinged top firmly, and take a measurement. 
See Figure 149 for an example of placing electronic parts.

Figure 149. Measuring Electronic Parts
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11 Test Stands
Configuring the Analyzer for the Test Stand
To measure small alloy parts and samples, place the part to be measured directly on the 
measurement window of the analyzer, shut the hinged top firmly, and take a measurement. 

Measuring Bulk Samples in Sample Cups

To measure bulk materials in sample cups, place the Sample Cup Holder into the Mobile Test 
Stand so that it rests on the lip of the oval cutout. See Figure 150 to see how the Sample Cup 
Holder is oriented.

 

Figure 150. Inserting the Sample Cup Holder

Then place the sample cup to be analyzed into the sample cup holder, shut the hinged top 
firmly, and initiate a measurement. See Figure 18 for an example of placing sample cups into 
the Sample Cup Holder.
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Configuring the Analyzer for the Test Stand
Figure 151. Inserting Sample Cup

Measuring Bulk Samples in Bags

To measure bulk materials in plastic bags, make sure the material to be tested is at least 1.5 cm 
deep over the measurement window of the analyzer. The cover of the test stand must be shut 
completely before taking a reading, which limits the maximum size of the bagged sample to 
that of the capacity of the test stand cavity. 

Place the sample bag into the test stand, shut the hinged top firmly, and take the 
measurement.

When the hood is lifted, your analyzer will display a red icon at the top of the touch screen, as 
in Figure 152.
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Configuring the Analyzer for the Test Stand
Figure 152. Mobile Test Stand Open Icon

When the hood is shut, your analyzer will display a green icon at the top of the touch screen, 
as in Figure 153.

Figure 153. Mobile Test Stand Closed Icon 

Your analyzer cannot make an analysis unless the icon is green. To remove your analyzer from 
the Mobile Test Stand, simply squeeze the tabs on either side of the cone and pull the analyzer 
down, gently but firmly, until it separates from the cone.
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 11 Test Stands
The Field Mate Test Stand
The Field Mate Test Stand
The Field Mate Test Stand is a multi purpose, ultra portable test stand. It is optimized for field 
analysis of 32mm sample cups and small bagged samples.

Figure 154. The Field Mate

The Field Mate has a pivoting top plate which covers a shielded cavity inside which the 
sample is placed. There are two insets which fit inside the cavity, optimized for the two most 
common sample types - bagged bulk samples and sample cups. 

There is a brace to support the analyzer on the underside of the base. Gently but firmly 
unsnap the brace by pushing down on the protruding black tab. The brace will pivot out and 
down 180 degrees. The brace helps compensate for the off-center weight of the analyzer when 
clipped into the pivoting top plate. 

To place your analyzer into the Field Mate, fit your analyzer's nose firmly up into the mating 
cone until the clips snap solidly into place on both sides of the analyzer’s front end. 
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The Field Mate Test Stand
Figure 155. The Field Mate with Top Plate Opened

The top plate is opened by pressing the large orange latch on the base. Inserts can be placed 
into the cavity, and samples can be placed into the inserts. The insert for bagged bulk samples 
(shown in Figure 156) has a spring loaded inner plate which pushes the sample up to contact 
the underside of the top plate for proper analysis. The insert for sample cups (shown in 
Figure 157) holds the cup at the proper height for analysis with a soft foam support. Tilt the 
top plate back until it latches with an audible click for analysis. This can be done with or 
without your analyzer clipped into the cone. 
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 11 Test Stands
The Field Mate Test Stand
Figure 156. The Field Mate Bagged Sample Insert

Figure 157. The Field Mate Sample Cup Insert

The top plate can also be completely removed by pressing the two small hinge tabs together 
towards the middle of the plate and lifting the plate from the base. This can be done with or 
without your analyzer mounted into the cone.
Thermo Scientific Niton XL2 Plus User’s Guide 183



11 Test Stands
The Field Mate Test Stand
Figure 158. The Top Plate Removed from the Base Unit

Removed from the base, the plate can be placed into the Test Guard, for soil screening in-situ.

Figure 159. The Test Guard

To insert the plate into the Test Guard, slide the front tab on the plate under the tab of the 
Test Guard.
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The Field Mate Test Stand
Figure 160. Inserting the Top Plate into the Test Guard

The interlocking tabs secure the front of the Test Guard to the plate.

Figure 161. The Front Tab

Squeezing the Hinge Tabs together, lower the back of the plate into the Test Guard. Release 
the tabs so the Hinge Tab Pins protrude through the holes on either side of the Test Guard. 
This secures the rear of the plate to the Test Guard.
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The Field Mate Test Stand
Figure 162. The Hinge Tab Pins

At this point, you can fit your analyzer into the cone. It may now be used for soil screening.
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The Field Mate Test Stand
Figure 163. The Top Plate Removed from the Base Unit

When the top plate is lifted, your analyzer will display a red icon at the top of the touch 
screen, as in Figure 164.

Figure 164. Field Mate Open Icon

When the plate is shut, your analyzer will display a green icon at the top of the touch screen, 
as in Figure 165.
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The Field Mate Test Stand
Figure 165. Field Mate Closed Icon

Your analyzer cannot make an analysis unless the icon is green.

To remove your analyzer from the Field Mate Test Stand, simply squeeze the tabs on either 
side of the cone and pull the analyzer up, gently but firmly, until it separates from the cone.
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 11 Test Stands
Configuring the Analyzer for the Test Stand
Configuring the Analyzer for the Test Stand
The test stand contains an RFID chip, which automatically configures your analyzer to 
properly work with the test stand. 

Proximity Start Feature

A feature you can optionally use is to set the analyzer to Proximity Start. 

Figure 166. Menu Path to Set Proximity Start 
Thermo Scientific Niton XL2 Plus User’s Guide 189



11 Test Stands
Configuring the Analyzer for the Test Stand
Press the trigger to initiate the reading, and disengage the Proximity Button by pressing the 
Latch and opening the plate to stop the reading. With this feature enabled, you do not need 
to hold the trigger down while the sample is being analyzed.

Figure 167. Stopping the Analysis by Opening the Plate

You can always use standard operation, as well as remote operation via NDTr.
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